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Getting Started with Security Analytics:

Introduction to Security Analytics

RSA Security Analytics is a distributed and modular system that enables highly flexible
deployment architectures that scale with the needs of the organization. Security Analytics allows
administrators to collect two types of data from the network infrastructure, packet data and log
data. The key aspects of the architecture are:

« Distributed Data Collection. The packet data is collected using a host called Decoder,
while the Log Decoder collects log events. The Decoder captures, parses, and reconstructs
all network traffic from Layers 2 - 7, or log and event data from hundreds of devices and
event sources and event sources. The Concentrator indexes metadata extracted from
network or log data and makes it available for enterprise-wide querying and real-time
analytics while also facilitating reporting and alerting. The Broker aggregates data captured
by other devices and event sources. Brokers aggregate data from configured Concentrators;
Concentrators aggregate data from Decoders. Therefore, a Broker bridges the multiple real-
time data stores held in the various Decoder/Concentrator pairs throughout the infrastructure.

o Real-time Analytics. The Security Analytics Event Stream Analysis (ESA) host provides
advanced stream analytics such as correlation and complex event processing at high
throughputs and low latency. It is capable of processing large volumes of disparate event data
from Concentrators. ESA uses an advanced Event Processing Language that allows analysts
to express filtering, aggregation, joins, pattern recognition and correlation across multiple

disparate event streams. Event Stream Analysis helps to perform powerful incident detection
and alerting.

RSA Analytics Warehouse. A Hadoop-based distributed computing system, which collects,
manages, and enables analytics and reporting on longer-term sets of security data, for
example, months or years. The Warehouse can be made up of three or more nodes depending
on the organization's analytic, archiving, and resiliency requirements.

Security Analytics Server. Hosts Reporting, Investigation, Administration, and other aspects
of the user interface. Also enables reporting on data held in the Warehouse.

o Capacity. Security Analytics has a modular-capacity architecture enabled with direct-
attached capacity (DACs) or storage area networks (SANs), that adapts to the organization's

short-term investigation and longer-term analytic and data-retention needs.
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Security Analytics provides large deployment flexibility. You can design its architecture using as
many as multiple dozens of physical hosts or a single physical host, based on the particulars of
the customer's performance and security-related requirements. In addition, the entire Security
Analytics system has been optimized to run on virtualized infrastructure. The following

image illustrates the Security Analytics Functional architecture:
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The System Architecture comprises these major components: Decoders, Brokers and

Concentrators, Archivers, ESA, Warehouse Connectors, RSA Warehouse. Security Analytics

components can be used together as a system or can be used individually.

o In a security information and event management (SIEM) implementation, the base
configuration requires these components: Log Decoder, Concentrator, Broker, Event Stream
Analysis (ESA), and the Security Analytics Server.

« In a forensics implementation, the base configuration requires these components: Decoder,
Concentrator, Broker, ESA, and Malware Analysis. An optional component is the Incident

Management service, which resides on the ESA system and is used to prioritize alerts.

The table provides a synopsis of each major component:

Getting Started with Security Analytics: Introduction to Security Analytics 8
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System Com-

ponent

Decoder / Log

Decoder

Concentrator /

Description

Security Analytics collects two types of data: packet data and log data.

Packet data, that is, network packets, are collected using the Decoder
through the network tap or span port, which is typically determined to be

an egress point on an organization's network.

A Log Decoder can collect four different log types - Syslog, ODBC,

Windows eventing, and flat files.

Windows eventing refers to the Windows 2008 collection methodology
and flat files can be obtained via SFTP.

Both types of Decoders ingest raw transactional data that is enriched,
closed out, and aggregated to the warehouse or other Security Analytics

components.

The process for ingesting and parsing transactional data is a dynamic

and open framework.

Any data that can be indexed on the Decoder is filtered by the

Broker respective Concentrator.
o Once data is stored in the Concentrator, it is streamed as metadata to
the RSA Analytics Warehouse.
Archivers o The Archiver is a host that enables long-term log archiving by indexing
and compressing log data and sending it to archiving storage.
o The archiving storage is optimized for long-term data retention, and
compliance reporting.
« Archiver stores raw logs and log meta data from Log Decoders for long
term-retention, and it uses Direct-Attached Capacity (DAC) for storage.
Note: Raw packets and packet meta data are not stored in
the Archiver.
9 Getting Started with Security Analytics: Introduction to Security Analytics
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System Com-

Description
ponent
Event o This ESA host provides event stream analytics such as correlation and
Stream Analysis complex event processing at high throughputs and low latency. It is

(ESA) capable of processing large volumes of disparate event data from

Concentrators.

o ESA uses advanced Event Processing Language that allows users to
express filtering, aggregation, joins, pattern recognition, and correlation

across multiple disparate event streams.

o ESA helps to perform powerful incident detection and alerting.

Warehouse Connector allows you to collect meta data and events from

Warehouse Con-
nectors Decoders and write them in Avro format into a Hadoop-

based distributed computing system.

e You can set up Warehouse Connector as a service on existing Log
Decoders or Decoders or it can be run as a virtual host in your virtual

environment.

o The Warehouse Connector contains the following components: Data

Source, Destination, and Data Stream.

RSA Analytics RSA Analytics Warehouse provides the capacity for longer term data
Warehouse archiving through a Hadoop-based distributed computing system that

collects, manages, and enables analytics and reporting on security data.

¢ RSA Analytics Warehouse requires a service called Warehouse
Connector to collect meta data and events from Decoder and Log
Decoder and write them in Avro format into a Hadoop-based distributed

computing system.

« Any incoming data at the Log Decoder and Concentrator is ultimately

forwarded to the Warehouse.

o A Warehouse typically consists of two units: Storage nodes and Direct
Attached Capacity (DAC).

« Entire data (not just meta data) is stored in the RSA Analytics

Warehouse and is available to Security Analytics when required.

Getting Started with Security Analytics: Introduction to Security Analytics 10
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Core Versus Downstream Components

In Security Analytics, the Core services ingest and parse data, generate meta data, and
aggregate generated meta data with the raw data. In the figure below, the Core services are
highlighted in blue; they are Decoder, Log Decoder, Concentrator, and Broker. Downstream
systems use data stored on Core services for analytics, therefore, the operations of downstream
services are dependent on Security Analytics Core services. The downstream systems are
highlighted in red; they are Archiver, Warehouse, ESA, Malware Analysis, Investigation, and
Reporting.

Although the Security Analytics Core services can operate and provide a good analytics solution
without the downstream systems, the downstream components provide additional analytics. ESA
provides real-time correlation across sessions and events as well as between different types of
events, such as log and packet data. Investigation provides the ability to drill into data, examine
events and files, and reconstruct events in a safe environment. The Malware Analysis service
provides real-time, automated inspection for malicious activity in network sessions and
associated files.
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At a very high level, Security Analytics performs two functions:

o Provides a graphical browser-based user interface to administer the Security Analytics

architecture, setup configurations and permissions for services.

o Acquires the data from the Warehouse, Decoders and Concentrators, performs analysis, and

runs alerts and reports.

o All Security Analytics modules share a common approach to presenting data and

configuration options using a series of dashboards, views, grids, and dialogs. This helps users

to navigate in a seamless and easily understandable way. Once familiar with the user

11
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interface, users can further improve their productivity by creating custom dashboards for
specific purposes. For example, a set of custom dashboards can present information for

different regions or different types of threats.

Security Analytics Modules

Security Analytics organizes administrative, analytical, and reporting tasks into modules
representing logical groupings of functions and tasks for services:

o The dashboard is the entry point for all Security Analytics modules, providing a portal into

functions of other modules for user convenience.

o The Administration module is the user interface for administering and monitoring hosts,
devices and event sources, and services. When configured, hosts, devices and event sources,

and services are available to other Security Analytics modules.

o The Investigation module is the user interface that allows visualization of packets captured by
Security Analytics hosts. Malware Analysis is the user interface for automated malware

analysis.

o The Live module is the user interface to access and manage resources available to customers

through the Live Content Management System.

o The Reports and Alerts modules provide the user interface for automated reporting and

alerting functions.

o The Incidents module provides the Incident Management function in Security Analytics. The
incident management function is an easy way to track the incident response process and
provides the following capabilities:

o Track the Incident Response in a consistent way.
« Automate the process of creating actionable security incidents from incoming alerts.

o Provide business context and investigational tools to help the team discover the root

causces.

o Track the remediation process in an automated way by integrating with a third party help

desk system.
o Track the Incident Response in a consistent way.
o Automate the process of creating actionable security incidents from incoming alerts.

« Provide business context and investigational tools to help the team discover the root

causces.

Getting Started with Security Analytics: Introduction to Security Analytics 12
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o Track the remediation process in an automated way by integrating with a third party help

desk system.

13
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Common Elements in a Browser Window

Security Analytics contains some some basic elements in every browser window. These features

are included in all views of Security Analytics.

To display this view, do one of the following:

o Log on to Security Analytics at https://<SA-IP>, where <SA-IP> is the Security Analytics
server [P address.

o In the Security Analytics menu, select Dashboard.

@ Dashboard @® W @ RSASecurity Analytics

Default Dashboard

Whats New ~@x f Shortcuts 28X f Available Services 28X
RSA Security Analytics Communit; B E
y Analy y FE) = P
Check out the latest discussions, new how-to's, events and happenings Configure Live Add a Service Investigate a Service =
around SA Connection =V
IE) IE) RN
Browse Live Resources  Setup Live Intel Sharing Manage Live Os Reporting Engine
Subscriptions
0
¥o) n
View My Jobs View My Notifications
Featured Live Resources ~@X fLive Subscriptions ~X I New Live Resources 28X
R Name Type Description R
Live Configuration is incorrect. Pleas Live Configuration is incort ease check the
configuration configuration
'8 achmin | Lastlogin: Monday, April 11, 2016 11:04:08 AM UTC | ) English (Urited Sates) | GMT0000 Send Us Feedback |

Features

Every browser window that is accessing Security Analytics includes these elements:
o The Security Analytics menu
o The Security Analytics toolbar

o The footer

Security Analytics Toolbar

At the top of all Security Analytics dashboards is the Security Analytics toolbar. Different
modules have different content based on available views. Here are two examples of the Security
Analytics toolbar.

@ Investigation © =~ ®Navigate  =Events % Malware Analysis 5 B @ RSA'security Analytics

& Administration =Hosts  SServices  NEventSources W Health&Wellness  3=System & Security 5 B @ RSASecurity Analytics

These are the features of the Security Analytics toolbar.

Getting Started with Security Analytics: Introduction to Security Analytics 14
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N

Security Analytics Menu

Module View options

Security Analytics menu

Jobs button .

Notifications button

Help button ﬂ

Security Analytics Menu

Contains options to access modules, Help, Profile, and
Sign Out. Some modules have a submenu of views.

Displays a view. The option for the currently displayed
view is highlighted.

Displays the current module as the title. Click to open a
drop-down menu from which you can view a module, view
the Profile, or sign out of Security Analytics.

Displays the Jobs tray, which provides information on jobs

for a user.

Displays the Notifications tray, which provides
notifications for a user.

Displays the online help for Security Analytics.

The Security Analytics menu is on the left side of the Security Analytics toolbar.

15
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3 Dashboard

¢y Dashboard

& Investigation

v Incidents
Alerts
Reports
Administration

@) Live

2 Profile

(H Sign Out

These are the options in the Security Analytics menu.

SEIT Description
Option P

Dashboard Displays the Security Analytics Dashboard.

Investigation  Displays the Investigation module with the Navigate view open. The submenu
has an option to display the Navigate view, the Events view, and the
Malware Analysis view.

Incidents Displays the Incident Management module.

The submenu has an option to display the Queue view, Alerts view,
Remediation view, and Configure view

Alerts Displays the Alerts module with the Configure view open. The submenu has
options to directly access the views: Summary and Configure.

Getting Started with Security Analytics: Introduction to Security Analytics 16
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Menu

Option Description

Reports Displays the Reports module with the Reports view open.

Administration Displays the Administration module with the Services view open. The
submenu has options to directly access the Administration views: Hosts,
Services, Event Sources, Health & Wellness, System, or Security.

Live Displays the Live module with the Configure view open. The submenu has
options to directly access the Live views: Search, Configure, and Feeds.

Profile Displays the Profile to configure user preferences, and view notifications and
jobs.
Sign Out Signs out of Security Analytics.
Footer

The page footer is at the bottom of the browser window.

2 =dmin | Lastlogin : Monday, April 11, 2016 10:50:49 AM UTC | @ English (United States) | GMT+00:00 Send Us Feedback | 10.6.1.0-160321122617.3.6a6f102

The footer provides the following information:

o The username of the logged on user

o The last login date and time of a user
o The current Security Analytics version
o The set time zone

o The set language

Send Us Feedback

The Send Us Feedback option opens a new email message addressed to our feedback center.
We appreciate your comments and suggestions, and consider them an integral part of our new
features and improvements process in Security Analytics.

17 Getting Started with Security Analytics: Introduction to Security Analytics
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Common Elements in a View

The Security Analytics modules that are listed in the Security Analytics menu (Administration,
Investigation, Live, Alerts, Reports, more) are called views, and each view provides functions
tailored for the module. In addition, there is a Profile view, accessible directly from the Security
Analytics menu, which presents options for user preferences.

To display a view, select a module from the Security Analytics menu. For example, Security
Analytics, Administration, Investigation, or Live. As you roll your cursor over the module,
you can select a view from the options menu. From within the module, you can select an

alternate view from the Security Analytics toolbar. For example, Administration has six views:

Hosts, Services, Event Sources, Health & Wellness, System, and Security.

This example of the Administration Hosts view illustrates some of the features of a view.

A Administration =Hosts SServices NEventSources W Health &Wellness = System @ Security O W @ RSASecurity Analytics
Groups Hosts
+ < + Discover X
Name O Name Host Services Total Memory CPU os Uptime Updates Actions.
Er e|o [ ] o NCE
E a -
O BB sssee 216% LinUx 26... 5 hours 22 minutes 39 se... %
O BN sseee omsw Linux 26... 5 hours 21 minutes 51 se... )
O n 15.58 GB 1.46% Lnux 26...  5hours 21 minutes 41 se... Update (7) O
O BN sseee as3m Linux 26... 5 hours 21 minutes 50 se... )
O 1558GB  7.2% LUnux 26...  3hours 14 minutes 17 se... Update (7) &
| Page 1  of1 | I C Displaying 1 -7 of 7
Features

Each view has different features. Any combination of these features is possible in a view:

o Toolbars

o Sections

o Panels: there are two different types of specialized panels, options panel and node tree
o Tabs

o Breadcrumbs

Getting Started with Security Analytics: Introduction to Security Analytics 18
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o Grids or tables

o Context menus

The general parts of a view are labeled in the figures below.

» Administratior © =Hosts  SServices M EventSources = W Health &Wellness 3= System B Security @  RSASecurity Analytics

Alarms Policies System Stats Browser  Event Source Monitoring  Settings

| Groups (3) | Hosts
Name Count 3 . . X ) X )
2 Stopped Services Stopped Processing Physical Drive Problerr = Logical Drive Problems Full Filesystems
Sail
© 0 4 0 host(s) 0 host(s) 0 host(s)
@ = status; ® CPU: 7.89% Memory: 13.80 GB/15.58 GB
Service Processing  Rate Name Service Type cPU Memory Usage
® Ready 0 - Broker Braker 0.7% 43,78 MB
® Ready 0 - Concen...  Concentrator 3.1% 334.79 MB
® Ready L ] 0 -Decoder  Decoder 0.6% 146.17 MB.
] status: @ CPU: 2.01% Memory: 1.69 GB/15.58 GB
Service Processing  Rate Name Service Type cPU Memory Usage
@ Ready [ ] 0 - Archiver  Archiver 0.5% 27.29 MB
] Status: @ CPU: 12.72% Memory: 5.82 GB/15.58 GB
Service Processing  Rate Name Service Type cPU Memory Usage
® Ready [ ] - -LogColl... Log Collector B.6% 705.50 MB
® Ready 0 -LogDec... Log Decoder 14% 1.21GB
| Page 1 of1 | | ¢ Displaying 1-5of 5

admin | @) English (United States) | GMT+00:00

& Administratior © = Hosts = SServices N EventSources W Health &Wellness 3= System 8 Security ©  RSASecurity Analytics

-Broker | Stats ©

- Broker @

- Change Service

Chart Stats Tray

Key Stats Service System Info Search X
Key Stats Rate Max Behind Status CPU 2% Stats
150005 0 145500 0 consuming System Memory 13.8GB
Build Date
Total Memory 15.6 GB stat Name:build.date
Process Memory 43.8 MB Path:/sys/stats/build.date
Max Process Memory 15.6 GB cPU
stat Name:cpU
Uptime 1 week, 6 days and 20 min Path:/sys/stats/cpu
Status Ready Max Process Memory
. e Stat Name:memory.process.max
Running Since 2015-Apr-21 10:55:09 Path:/sys/stats/memary.process.max
Current Time 2015-May-04 11:15:31

Memory Used
stat Name:memory.used
pathi/index/stats/memory.used

Gauges - Page 1 of 1

Meta Rate (current)

Stat Name:meta.rate
X X Path:/broker/devices/ :50005/stats/meta.rate

Memory Process CPU Memory Process Max

Meta Rate (current)

stat Name:meta.rate

Path:/broker/stats/meta.rate

43.8MB 50%

35.0MB 52.5MB 409 B0%. 12.5G8 1 Meta Rate (maximum)
) . Stat Name:meta.rate max
ZaME rame s o path:/broker/stats/meta.rate.max
17.5MB 70.0MB 20% £0% 6268 Meta Rate (maximum)
Stat Name:meta.rate.max
" i -5
BAMB ARENE 78.8MB 10% 2% a0% 3168 1s5aE path:/broker/devices/ :50005/stats/meta.rate.max

Process Memory
Stat Name:memory.process
Path:/svs/stats/memarv.nrocess

of2 | ) M | C  Stas1-120f15

00" MemoryProcess g7.6MB 0% cPu 100% 00" Memory Process M

| Page 1

2 admin | %}Engﬂsh (United States) | GMT+00:00 Send Us Feedback | 10.5.0.0.17717-1

19 Getting Started with Security Analytics: Introduction to Security Analytics



Security Analytics Getting Started Guide

Administratior ® = Hosts £ Services

I Info @

N\ Event Sources W Health & Wellness 2= System & Security ©  RSA ‘Security Analytics

Version Information

Updates

Current Version 10.5.00.177171
Licensing Current Build 20150503204524
Email License Server ID

License Status Enabled Disable

Global Notifications
Legacy Notifications
System Logging
Global Auditing

Jobs

Live

URL Integration
Context Menu Actions
Investigation

ESA

HTTP Proxy Settings

Send Us Feedback | 10.5.0.0.1771

Inited States) | GMT+00:00

& Administratior = Hosts = Services 3 Event Sources ¥ Health & Wellness 2= System & Security ©  RSASecurity Analytics

e[ deviceappliance

| €5 English (United States) | GMT+00:00

& Change Service | -Archiver | Explore &
E ¢ ! - Archiver (Archiver)
archiver
= [an - Archiver (
connections
B8 archiver database
B config index
[recovery logs
B rules rost
[ application sdk
[T carrelatian sarvices
[Tdevices storedproc
[dstats sys
B[] connections | users
E[] database deviceappliance
B[ Jindex
B[ TJlogs
m[Jrest
m[]sdk
[Jservices
&[] steredproc
B[ Jsys
E[Jusers

Send Us Feedback | 10.5.0.0.17717-1

The following table provides descriptions of the features labeled above.

Getting Started with Security Analytics: Introduction to Security Analytics
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o o

1 tabs Organize the features of a panel into easily viewed and accessible groups

so that you don't have to scroll down the page to view everything. If a panel
has many options, the tabs make it easier to navigate to the right group of

options in a panel.
2 toolbar A toolbar may apply to the entire view, to a section, or to a panel.

3,4  sections  Within a panel, some dashboards have sections that organize information
(top to from top to bottom; for example, the Service Info view has two sections in
bottom)  the Service panel, the Service section at the top and the Session Inform-

ation section at the bottom. Sometimes you may need to scroll down to

view a section near the bottom of the panel.

5,6  panels Within a view, most dashboards have panels that organize information from
(left to left to right; for example, the Service Stats view has two panels, the main
right) panel on the left and the Chart Stats Tray panel on the right. The Chart

Stats Tray is not the main focus, so it is collapsible to allow more space in

the main panel.

7 options The options panel is a panel that lists options available in a view. Fre-
panel quently, the options panel doesn't have a title. A list of choices without a

header are called options.

8 node tree A node tree is a list of nodes with expandable and collapsible folders.

Breadcrumbs

Breadcrumbs display the options selected to reach this view. Click on a crumb to go back to the
view or menu. In some modules breadcrumbs have additional functions. For example, in
Investigation a breadcrumb represents a sequence of queries used to reach the current drill point
and you can edit the query directly from the breadcrumb.

21 Getting Started with Security Analytics: Introduction to Security Analytics
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Context Menus

Context menus offer options that pertain specifically to the current context. In certain views,
hovering over an item and right-clicking the mouse displays the options that can apply to that
item. Throughout the Security Analytics documentation, context menus are discussed in the
pertinent modules and views.

A good example of a context menu is shown in the Navigation view. When you right-click a
count for a meta value (the green number in the parentheses), the menu offers one option: to
open the drill in a new tab.

1ﬂ_1g,?g_;..q;;{1ﬁ1 1010 '.-'-:; m; (1R . 10.10.7
1.10.79.75(16) - Open in New Tab P.E.
- 10.10.79.219 (‘ryyr=rorrorrozrormr=10.1

When you right-click on the meta value (blue text), a different context menu is displayed. In this
context, there are options to scan for malware, look up the value in Investigation and to display
the same drill in a new tab, apply the reverse of this drill ('EQUALS) in the same tab, or apply
the reverse of this drill in a new tab.

ger tmmnran cara (181 = acv imapeg-amazon.com (14) - www.amazon.

10 Live Lookup images-amazon.com (8) - ecn-analytics-n:
d Scan for Malware - d1ge0kk1I5kms0.cloudfront.net (4) - g
Data Science »
Investigation » Refocus Investigation in New Tab
External Lookup » Apply Drill in New Tab

(5] - S— Apply IEQUALS Drill in New Tab !
(24) - 1(23) - Apply IEQUALS Drill 1
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Dashboards

A dashboard is a group of dashlets that give you the ability to view in one space key snapshots of
the various modules that you consider important. In Security Analytics, you can compose
dashboards to obtain high-level information and metrics that portray the overall picture of a
Security Analytics deployment, displaying only the information that is most relevant to day-to-
day operations.

By default, the Security Analytics Dashboard is displayed when you log into Security Analytics,
and it is populated with a few useful dashlets to get you started with your own customizations.
The dashlets for all Security Analytics modules are available to add to the default Security
Analytics dashboard or a custom Security Analytics dashboard.

To display the Security Analytics dashboard, do one of the following:
o Log on to Security Analytics, and the application opens to the Security Analytics dashboard.

o Inthe Security Analytics menu, select Dashboard.

I ————————————
(@ Dashboard H B @ RSAsecurity Analytics

Default Dashboard ©

Whats New ~@x I Shortcuts ~@x f Available Services 28X
. . S
RSA Security Analytics Community l\ B E T F o pe
Check out the latest discussions, new how-to's, events and happenings Configure Live Add a Service Investigate a Service Oy Event Stream Analysis
around SA Connection
O g Concentrator
IR 15 ) B
Browse Live Resources Setup Live Intel Manage Live O Maluware Analysis
Sharing Subscriptions Og Decoder
é u Og Broker
o ° O g IPDB Extr:
View My Jobs View My Notifications Og Incident Management
O & Malware Analysis
Featured Live Resources ~%&x fLive Subscriptions 2% I New Live Resources 28X
) Name Type Description )
Live Configuration is incorrect. Please check the Live Configuration is incorrect. Please check the
configuration. configuration.

| 2 admin | @) English (United tates) | GMT+05:30 Send Us Feedback |

The Default Dashboard

The default dashboard is configured to display specific dashlets in specific positions. The default
dashboard serves as an example of dashboard composition and a starting point for customization.

e You can customize the information on the default dashboard by editing dashlets, adding

dashlets, moving dashlets, maximizing dashlets, and deleting dashlets.
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o After modifying the default dashboard, you can restore the default dashboard to its original

layout.

o The default dashboard cannot be deleted.

Note: From 10.6.3 onwards, the Admin Service Monitor dashlet is not available.

Custom Dashboards

You can create custom dashboards to serve a particular purpose; for example, to represent a
specific geographical or functional area of the network. Each custom dashboard is appended to
the Dashboard Selection List.

Once custom dashboards are created, you can:

o Switch between dashboards by selecting an option from the Dashboard Selection List
o Delete any custom dashboard

« Import or export a dashboard

Each dashboard has:
o The dashboard toolbar
o The dashboard title and the Dashboards Selection List

e Zero or more dashlets

Out-Of-The-Box Dashboards

Out-Of-The-Box dashboards are dashboards that will be available to the user on upgrade to
10.6.3. By default, these dashboards are disabled on Security Analyticsinstallation. For more
information on each Out-Of-The-Box dashboards, see the OOTB Dashboards PDF.

Dashboard Title

The dashboard title reflects the current module; for example, Dashboard.

€D Dashboard

Default Dashboard ~

Dashboard Toolbar

The dashboard toolbar is available next to the current dashboard title. The dashboard toolbar
allows various operations on dashboards and dashlets.
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o Jowen

Favorite

Add Dashlet

Remove Dash-

board

Change Dash-
board Layout

Create New

Dashboard

Rename Dash-

board

Restore Default
Dashboard

Copy Dashboard

Export Dash-
board

Import Dash-
board

Share Dashboard

Sets the selected dashboard as Favorite.

Displays the Add a Dashlet dialog, where you add a dashlet to the current
dashboard.

Deletes a custom dashboard. The default dashboard cannot be deleted.

Displays the Change Dashboard Layout dialog, where you change the lay-

out of the dashboard to one of five options.

Displays the Create a Dashboard dialog, where you define a custom dash-

board.

Displays the Rename Dashboard dialog, where you change the dashboard
title.

Restores the default dashboard to its original appearance, with the default

dashlets in their original positions.

Creates a copy of a dashboard which can be shared with other roles to be

modified.

Creates a .cfg file containing the structure of the current dashboard.

Adds a dashboard based on the previously exported .cfg file.

Shares a dashboard with other roles for viewing.

Note: The delete, export, and share options are not available for OOTB Dashboards.
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Dashboard Selection List

You can access custom dashboards on the Dashboard selection list. When you select a custom
dashboard, its title is displayed below the Security Analytics toolbar.

€D Dashboard

Administrator Shared Dashboard = ~

Default
NS % Administrator Shared %5

Admin Shared ":

Dashlets

Security Analytics uses dashlets to display focused subsets of system information, services, jobs,
resources, subscriptions, rules, Incident Queue activity, Incident Analysts activity, and other
information.

Security Analytics modules can display only those dashlets presented in the Add a Dashlet
dialog. The main dashboard offers all Security Analytics dashlets. This is an example of
currently available dashlets.

Type Admin Mews hd

Title Admin Mews

Admin Service List

Admin Service Monitor
Dashboard RSA First Watch

Dashboard Shortcuts

Dashboard Whats Mew
Investigation Jobs
Investigation Top Values
Live Featured Resources
Live Mew Resources

Live Subscriptions

Live Updated Resources
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Controls for a dashlet are in the title bar. All dashlets use a common set of controls, and only
those that apply to the particular dashlet appear in the title bar.

N e

Fa

<

»

«

X

Collapse

vertically

Expand

vertically

Page for-

ward

Page
back

Last Page

First Page

Reload

Settings

Maximize

Delete

Collapses the dashlet vertically so that only the title is visible.

Expands the dashlet to its original size.

In dashlets with more than one page, moves to the next page.

In dashlets with more than one page, moves to the previous page.

In dashlets with more than one page, moves to the last page.

In dashlets with more than one page, moves to the first page.

Reloads the dashlet.

Displays configurable settings for the dashlet.

In some dashlets with content that does not fit horizontally within the

width of the dashlet, maximizes a chart or a dashlet to full screen.

Deletes the dashlet from the dashboard.

The following options have been added to RE Top Alerts, RE Alert Variance and RE Realtime
Charts Dashlets on left-click:

o Hide For 24 Hours: This option allows you to hide the data for a selected value for the next 24

hours. After 24 hours, the data will automatically be displayed on the dashlet, if the value is

on the top.

o Hide Permanently: This option allows you to hide the data for a selected value permanently.
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RE Alert Variance A/ CX
4
Investigate
i Hide For 24 Hours
g Hide Permanently
L

Manage Hidden Values

T T T
T TR-T: 11-40)

s TestRule |

o Manage Hidden Values: This option displays a list of all the hidden values. You can select
the checkbox for a value and click Remove to unhide the data.

Manage Hidden Value

U Chart Valus Hide Permanent

O 10.31.244.199 false

Cancel Remowve
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Note: These options are available for Default, Custom, and OOTB Dashboards but it is not
available for Shared Dashboards. However, when you edit a value in an OOTB Dashboard it
is an user-specific change. The changes made to an OOTB Dashboard will be applicable only
to your dashlet and cannot be viewed by other users who use the same OOTB Dashboard. For
example, if you hide a value in an Overview Dashboard, the change will be applicable only to
your dashlet. If an another user views the same Overview Dashboard, the value will still be
displayed.
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Dashlets

Dashlets for all Security Analytics modules are available to add in the default Security Analytics
dashboard or a custom Security Analytics dashboard. All dashlets have a common set of controls
described in Dashboards. This is an example of some currently available dashlets.

Type Admin Mews ~

Title Admin Mews
Admin Service List
Admin Service Monitor
- Dashboard RSA First Watch
- Dashboard Shortouts
Dashboard Whats Mew

Investigation Jobs
Investigation Top Values
Live Featured Resources
Live Mew Resources
Live Subscriptions

Live Updated Resources
Some dashlets have additional configuration parameters and controls, for example the Reports
Realtime Chart, Malware and Top Listing of Highly Suspicious Malware dashlets. For more
information on these additional controls, read the topic that pertains specifically to that dashlet.
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Getting Started with Security Analytics: Terminology

A

Administration The Administration module is the user interface for administering and mon-

module

Alerts

Anonymised
data

anonymization

Archiver

itoring appliances, devices, and services. When configured, appliances,

devices, and services are available to other Security Analytics modules.

The Security Analytics Alerts module is the user interface for automated

alerting functions.

"Data are anonymised if all identifying elements have been eliminated from a
set of personal data. No element may be left in the information which could,
by exercising reasonable effort, serve to re-identify the person(s) concerned.
Where data have been successfully anonymised, they are no longer personal
data." (Source - EU DP LAW_HANDBOOK) This term is defined as part

of the Security Analytics data privacy solution.

The Privacy Technology Focus Group defines anonymization as a technology
that converts clear text data into a nonhuman readable and irreversible form,
including but not limited to one-way hashes and encryption techniques in
which the decryption key has been discarded. This term is defined as part of

the Security Analytics data privacy solution.

The RSA Archiver is an appliance that enables long-term log archiving by

indexing and compressing log data and sending it to archiving storage.
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Broker The RSA Broker is an appliance and a service in the Security Analytics network.

Brokers aggregate data captured by configured Concentrators, and Concentrators
aggregate data from Decoders. Therefore, a Broker bridges the multiple real-time
data stores held in the various Decoder/Concentrator pairs throughout the infra-

structure.

Cc

capacity Security Analytics has a modular-capacity architecture enabled with direct-
attached capacity (DACs) or storage area networks (SANs), that adapts to the
organization's short-term investigation and longer-term analytic and data-reten-

tion needs.

collections Collections are log retention sets for storing log data. For each collection, you
can specify how much of the total storage space to use and how many days to

retain the logs in the collection. You configure collections in Archiver.

Concentrator The RSA Concentrator is an appliance and service in the Security Analytics
network. Concentrators index metadata extracted from network or log data and
makes it available for enterprise-wide querying and real-time analytics while

also facilitating reporting and alerting.

Core Data-  This refers to the combination of the Packet, Meta, Session, and Index data.

base
Core ser- In Security Analytics, the Core services ingest and parse data, generate meta
vices data, and aggregate generated meta data with the raw data. The Core services

are Decoder, Log Decoder, Concentrator, and Broker.
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D

dashboard  The Security Analytics dashboard is the user interface displayed in a browser
when logged on to Security Analytics. It can also be referred to as the dash-
board in the generic sense. For example: You can create custom dashboards in
the Security Analytics dashboard. In the specific sense "Security Analytics dash-
board" replaces "Unified Dashboard".

Decoder The RSA Decoder is an appliance and service in the Security Analytics net-
work. In the Security Analytics network, packet data is collected using an appli-
ance called Decoder, while the Log Decoder collects log events. The Decoder
captures, parses, and reconstructs all network traffic from Layers 2 - 7, or log

and event data from hundreds of devices.

downstream As opposed to core components, downstream systems use data stored on Core
system and  services for analytics, therefore, the operations of downstream services are
components dependent on Security Analytics Core services. The downstream systems are

Archiver, Warehouse, ESA, Malware Analysis, Investigation, and Reporting.

drill point A set of data that an analyst has brought into focus using queries and filters in
the Investigation view. In effect, the analyst drills into the captured data to find

interesting data that may harbor harmful files or code.

E

Event The RSA Event Stream Analysis (ESA) appliance provides advanced stream ana-
Stream  lytics such as correlation and complex event processing at high throughputs and low
Analysis latency. It is capable of processing large volumes of disparate event data from Con-
(ESA) centrators. ESA uses an advanced Event Processing Language that allows analysts
to express filtering, aggregation, joins, pattern recognition, and correlation across
multiple disparate event streams. Event Stream Analysis helps to perform powerful

incident detection and alerting.
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EVP Events per second is a measure of the processing capacity for an RSA host that is

consuming data.

F
Term Description
Forensics In a forensics implementation, the base Security Analytics configuration

implementation requires these components: Decoder, Concentrator, Broker, ESA, and Mal-
ware Analysis. An optional component is the Incident Management service,

which resides on the ESA system and is used to prioritize alerts.

FirstWatch RSA FirstWatch is a research and analysis organization focused on emer-
ging, sophisticated threats around the globe. Tracking over 5 million IPs and
domains and dozens of unique threat sources, RSA FirstWatch delivers situ-
ational awareness and threat intelligence from across RSA’s research and

incident response community.

G

Global Global Audit Logging provides Security Analytics auditors with consolidated

visibility into user activities within Security Analytics in real-time from one

centralized location. This visibility includes audit logs gathered from the Security

Logging Analytics system and the different services throughout the Security Analytics
infrastructure.

Audit

H

hashing An obfuscation method used to protect sensitive data.

Getting Started with Security Analytics: Introduction to Security Analytics 34



Security Analytics Getting Started Guide

host Physical equipment or virtual machine, designated by a Fully Qualified Domain

Name (FQDN) or IP address, on which any Security Analytics service is installed
[that is the Security Analytics server, appliance service, Archiver service, Broker
service, Concentrator service, Broker service, Decoder service (Packets and Logs),
Hybrid, Malware Analysis service, Event Stream Analysis service, Log Collector
service, Security Analytics Warehouse service, Workbench service, Reporting

Engine service, and IPDB Extractor service].

Term Description

Identifiability "An individual is identified in this information; or if an individual, while not
identified, is described in this information in a way which makes it possible to
find out who the data subject is by conducting further research.” (Source - EU
DP LAW_HANDBOOK) This term is used when discussing the Security Ana-

lytics data privacy solution.

Incident Man- The Incident Management service resides on the ESA system and is used to pri-

agement ser-  oritize alerts.

vice

Incidents The Incidents module provides the Incident Management function in Security

module Analytics. The incident management function is an easy way to track the incid-
ent response process.

Index The index is a collection of files that provides a way to look up Session IDs

using meta values.

Investigation The Investigation module is the Security Analytics user interface that allows
module visualization and reconstruction of packets and logs captured by Security Ana-

lytics appliances.
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J

Job

system

L

The Security Analytics jobs system lets you begin a long-running task and continue
using other parts of Security Analytics while the job is running. Not only can you mon-
itor the progress of the task, but you can also receive notifications when the task has
completed and whether the result was success or failure. While you are working in

Security Analytics, you can open a quick view of your jobs from the toolbar.

Live

module

Log

Decoder

The Live module is the Security Analytics user interface to access and manage

resources available to customers through the Live Content Management System.

A Log Decoder is a type of Decoder that collects logs rather than packets. It can
collect four different log types - Syslog, ODBC, Windows eventing, and flat files.

Malware

Analysis

Message

Digest

meta DB

meta ID

Malware Analysis is an appliance and a co-located service in Security Analytics.
The service is used for automated malware analysis and is accessible through the

Investigation module.

Uses a one-way hash function to turn an arbitrary number of bytes into a fixed-

length byte sequence. This is used as part of a data privacy solution.

The meta database contains items of information that are extracted by a Decoder or
Log Decoder from the raw data stream. Parsers, rules, or feeds can generate meta

items.

A number used to uniquely identify a meta item in the meta database.
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meta A Decoder ingests and parses raw data, creating meta items (meta data) in the pro-

data or cess.
meta

items

meta key A name used to classify the type of each meta item. Common meta keys include

ip.src, time, or service.

meta Each meta item contains a value. The value is what each parser, feed, or rule gen-

value erates.

metered Metered licensing is a Security Analytics licensing method based on a throughput
licensing per day of logs (SIEM) or network packets (Network Monitoring and Network Mal-
ware), combined with the separate purchase of the hardware needed to deploy the

system and meet customers' retention requirements.

N

NetWitness or  An RSA Broker, Concentrator, Decoder, Log Decoder, or Log Collector. If

NextGen you see the term NextGen device, or NetWitness device change it to Core
device device.
(o]

Out-of-the-  Security Analytics 10.5 ships with a default Trial out-of-the-box license that
box trial enables customers to use the product with full functionality for 90 days. The 90-
licensing day time period begins when the Security Analytics user interface is configured

and used for the first time.
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Out-of-
Compliance

banners

P

A red banner is displayed during log on if your license is expired or you have
exceeded your allotted usage. You may also see a red banner if your license has
internal errors. A red banner cannot be dismissed. A yellow banner is displayed
during system log on if your license is approaching expiration or you are nearing
your allotted usage. You can dismiss the yellow banner by clicking the Dismiss

button.

packet ID

packet DB

Personal data

R

A number used to uniquely identify a packet or log in a packet database.

The packet database contains the raw, captured data. On a Decoder, the
packet database contains packets as captured from the network. Log
Decoders use the packet database to store raw logs. The raw data stored in
the packet database is accessible by a Packet ID, however, this ID is typ-

ically never visible to the end user.

"Under EU law, personal data are defined as information relating to an iden-
tified or identifiable natural person, that is, information about a person whose
identity is either manifestly clear or can at least be established by obtaining

additional information." (Source - EU_DP LAW_HANDBOOK)

RSA Ana-
lytics

Warehouse

A Hadoop-based distributed computing system, which collects, manages, and
enables analytics and reporting on longer-term sets of security data, for example,
months or years. The Warehouse can be made up of three or more nodes depend-
ing on the organization's analytic, archiving, and resiliency requirements. It
requires a service called Warehouse Connector to collect meta and events from
Decoder and Log Decoder and writes them in Avro format into a Hadoop-based

distributed computing system.
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Reports The Reports module is the Security Analytics user interface for automated report-
module ing functions.
Roles In Security Analytics, roles determine what users can do. A role has permissions

assigned to it and you must assign a role to each user. The user then has per-

mission to do what the role allows.

S

Security Ana-  The following products are part of the Security Analytics Core suite:
lytics Core Decoder, Log Decoder, Concentrator, Broker, Archiver, Workbench.
(formerly Nex-

tGen)

Security Ana-  The web server for reporting, investigation, administration, and other aspects
lytics Server of the analysts interface. Also enables reporting on data held in the Ware-

house.

Sensitive data ~ Regulatory mandates in some locations, for example the European Union
(EU), require that information systems provide a means of protecting data
when operating on sensitive data. Any data that could directly or indirectly
depict "Who did what when?" may be considered personally identifiable or

sensitive data.

Service A service runs on a host and performs a unique function, such as collecting
logs or archiving data. Security Analytics services include Archiver, Broker,
Concentrator, Decoder, Event Stream Analysis, Incident Management, [IPDB
Extractor, Log Collector, Log Decoder, Malware Analysis, Reporting

Engine, Warehouse Connector, and Workbench.

Service-based  This is a per-service permanent Security Analytics license that has no expir-
licensing ation date. Support for service-based licensing is applicable for all appli-

ances that require a license.
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session

session ID

session DB

SIEM imple-

mentation

Subscription

licensing

T

On a packet Decoder, a session represents a single, logical, network stream.
For example, a TCP/IP connection is one session. On a Log Decoder, each
log event is one session. Each session contains references to all the Packet

IDs and Meta IDs that refer to the session.
A number used to uniquely identify a session in the Session DB.

The session database contains information that ties the packet and meta

items together into sessions.

In a security information and event management (SIEM) implementation, the
base Security Analytics configuration requires these components: Log
Decoder, Concentrator, Broker, Event Stream Analysis (ESA), and the Secur-

ity Analytics server.

Subscription licenses for Security Analytics are offered for a specific time
period that ranges from 12 to 36 months. Once licensed, subscription licenses

are non-cancellable and non-downgradeable.

Transient In Security Analytics, transient data is not stored on disk. When a meta key is

data marked as transient in the custom index file or the Services Config view where

parsers for the service are configured, the Decoder, Log Decoder does not save

the meta key to disk, but holds it in memory where it can be analyzed until over-

written.
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Vv

Virtual (Formally virtual appliance) Virtual machine, designated by a Fully Qualified

host Domain Name (FQDN)) or IP address, on which any Security Analytics service runs
(that is the appliance service, Archiver service, Broker service, Concentrator ser-
vice, Broker service, Decoder service (Packets and Logs), Hybrid, Malware Ana-
lysis service, Event Stream Analysis service, Log Collector service, Security
Analytics Warehouse service, Workbench service, Reporting Engine service, and

IPDB Extractor service. A virtual instance of a Security Analytics appliance.

w

Warehouse Warehouse Connector collects meta and events from Decoders and writes them
Connector  in Avro format into a Hadoop-based distributed computing system. Y ou can set
up Warehouse Connector as a service on existing Log Decoders or Decoders or

it can be run as a virtual appliance in your virtual environment.

Windows  Windows eventing pertains to Log Decoders, and refers to the Windows 2008 col-

eventing lection methodology and flat files can be obtained via SFTP.
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Getting Started with Security Analytics:

Procedures

In Security Analytics, users must open a browser and log on. To make the most of Security
Analytics, you need to know how to manage jobs and notifications, configure dashboards and
grids, customize application settings such as language and time zone, and change your password.

These procedures are intended for all users learning to work in Security Analytics.

o Accessing Security Analytics

e Changing Your Password

o Configuring Application Preferences

e Viewing Help in the Application

o Configuring Dashboards

e Configuring Grids

e Managing Jobs

e Viewing and Deleting Notifications

Accessing Security Analytics

Accessing Security Analytics can vary based on your environment. Y ou may have an internal
Security Analytics user account or an external Security Analytics user account. Internal user
accounts are local to Security Analytics and internal users can log on to Security Analytics and
receive role-based permissions. External user accounts authenticate outside of Security
Analytics and are mapped to Security Analytics roles. If you are an external user and you cannot
access Security Analytics or view the information that you need within Security Analytics,
contact your System Administrator. Your Administrator can assign the appropriate roles to your
account.

Note: If you are logging on to Security Analytics from an Internet Explorer 10 browser
window, the following error may be displayed:

The page can't be displayed. You need to enable the TLS 1.1 protocol in your
browser as follows:

Navigate to Internet options > Advanced > Settings > Security. In addition to your other
protocols, ensure that the TLS 1.1 protocol is enabled. Click Apply. Reload the page.

When you attempt to log in to Security Analytics, your account can be in one of the following
states:
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o Valid: You can successfully log on to Security Analytics.

o Locked out: You are unable to log on because there were too many attempts to log in to your

account with bad credentials. This is temporary. Contact your Administrator for assistance.

o Expired: You can authenticate to Security Analytics, but you must change your password

before accessing Security Analytics.

To access Security Analytics:

1. Use a Security Analytics icon provided by your Administrator, or type the following in your
web browser:
https://<hostname or IP address>/login
Where <hostname or IP address> is the hostname or IP address of your Security
Analytics server.

The Security Analytics login screen is displayed.

= N

RSA ‘Security Analytics

Username

Password

— ["Login |

10.6.0.0220755.

L4

2. Type your username and password, and then click Login.
If your Login is successful, you will see an initial view based on your user profile

preferences.
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The following figure shows an example of the Security Analytics default dashboard.

(D Dashboard d B @

RSA Security Analytics

Default Dashboard © | +

Whats New Shortcuts Available Services
A ECAT LD B a8
K[ 7 0 # | Name ~ Address Type
— KEE I A‘ Configure Live Add a Service Investigate a o Concentrator
Connection Service 4
HUNT DOWN UNKNOWN MALWARE Hé Warehouse Cor..
MISSED BY OTHER TOOLS a@ l a I a [} & Decoder
[ Browse Live Setup Live Intel Manage Live | = & Warehouse Con..
Resources Sharing Subscriptions O & Archiver1 Archiver
é u [ 4 Archiver 2 Archiver
Lod o [} & Broker Broker
View My Jobs View My [] 4 ESA-ContextHub Context Hub
Notifications
[ & ESA-EventStrea.. Event Stream An...
Featured Live Resources ~ & [ Live Subscriptions ~ > I New Live Resources 28X
’ﬁ Palevo Tracker Domains e Type Description
B, created May 16,2012 1:03:08 AM
cated Jul 31, 2015 1:1328 AM
[BY RS FirstWatch Insider Threat Domains
~ created Feb9,2012 4:48:16 PM
Updated Nov 18, 2015 2:18:56 PM No matching resources found.
ﬁ RSA FirstWatch APT Threat Domains
BYY crested May 16,2012 1:07:2 AM
updated Feb 11, 2016 8:08:43 AM
2 admin | @)English (United States) | GMT+00:00 Send Us Feedback | 10.6.0.0.22075-5

If you are locked out:

If you try too many times to log in with an incorrect username or password, your account will
lock. Contact your Administrator to unlock your account.

If your account is expired:

1. In the dialog box, type a new password, confirm it, and click Save.

Password Change Required; Enter New Password

Mew Password:

Confirm Password:

Cancel

2. Click OK to confirm that your password was successfully changed.
Y ou have a maximum of 5 minutes to enter your new password. Your session could time out
sooner depending on the session and idle time security settings set by your Administrator.
If your session times out, log in again with your old password and then change your

password.
If you forgot your password:
1. On the Security Analytics login screen, click the Lost Your Password? link.

2. Inthe Lost Password dialog, type your username and click Send.
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Lost Password

Username:

Y ou should receive an email with instructions. If you do not receive an email, contact your

Administrator to add an email address to your account.

If you do not have the appropriate access to Security Analytics:

If you are able to log in successfully to Security Analytics, but you are not able to view the
information that you need, it is possible that you need a user role assigned to your user account.
Contact your Administrator for assistance.

Changing Your Password

Users can change the password that they use for Security Analytics authentication in the Profile
View > Preferences panel. The password of the user is updated on Security Analytics Core
services, unless the user is the admin user. The password of the admin user does not propagate
to Core services.

Note: For Core services, this applies to untrusted connections only. When a Core service uses
a trusted connection, the user does not enter a password so no update is required.

To change your Security Analytics password:
1. Inthe Security Analytics menu, select Profile.

2. In the options panel, select Preferences.

The Preferences panel is displayed with the General tab open.
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I Preferences Preferences
Notifications General | Investigation

Jobs

Authentication

Current Password
MNew Password

Confirm MNew Password

Apply

Application Settings

Language English (United States) v
Browser Time Zone UTC (GMT+00:00) hd
Default Component Dashboard v

™ Enable Notifications

M Show Context Menus

Apply

3. Inthe Authentication section, in the Current Password field, enter your current password
that you used to authenticate Security Analytics.

4. Inthe New Password field, enter the password you want to use for the next login.
5. Inthe Confirm Password field, re-enter the same password to confirm.

6. Click Apply.
You will be logged out from Security Analytics for the changes to take effect. The new
password becomes effective form the next time you log on to Security Analytics.

Configuring Application Preferences

User preferences that apply to the Security Analytics application in general are documented in
this section. Preferences that apply specifically to Investigation are described in the Configure
Navigate View and Events View topic in the Investigation and Malware Analysis Guide.

You can view and manage different user preferences in the Preferences panel. You can:

o Set the application language

¢ Set the browser time zone
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o Set the default component
o Enable notifications

o Enable context menus

These preferences apply to your own profile.

View User Preferences

To view user preferences:

1. Inthe Security Analytics menu, select Profile.

2. In the options panel, select Preferences.

1 Profile : M B @ RSA Security Analytics

| Preferences Preferences
Naotifications General Investigation
Jobs o
Authentication
Password

Confirm Password

Application Settings

Language English (United States) hd
Browser Time Zone UTC (GMT+00:00) ~
Default Component Dashboard .

[™ Enable Notific

™ Show Context Menus

Apply v

2 admin | @ English (United States) | GMT+00:00 Send Us Feedback | 10.6.0.0.21087-1

Set the Language, Browser Time Zone, and Default Component for Security
Analytics

The default language for all of the dashboards, dashlets, views, and dialogs that you see is the
preferred language that your browser sends. If Security Analytics is not localized to that
language, the default language is English (United States). You can change the language to other
languages in which Security Analytics has been localized. These settings can be configured in
the Application Settings section.
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To change the language, browser time zone, and default component of Security Analytics:
1. Select a localization in the Language drop-down list.
2. Select a time zone in the Browser Time Zone drop-down list.

3. Select the component that serves as the opening view when you log on to Security Analytics

in the Default Component drop-down list.

4. Click Apply.

The selected settings become effective immediately.

Enable or Disable System Notifications for Your User Account

By default, Security Analytics system notifications are enabled when a new user account is
created. Each user can change this according to preference.

To enable or disable notifications for your user account:

1. Inthe Application Settings section, click the Enable Notifications checkbox.

2. Click Apply.

The new preference becomes effective immediately.

Enable or Disable Context Menus for Your User Account

By default, Security Analytics context menus are enabled when a new user account is created.
Context menus provide additional functions for specific views when you right-click a view. Each
user can change this according to preference.

To enable or disable context menus for your user account:
1. Inthe Application Settings section, click the Show Context Menus checkbox.

2. Click Apply.

The new preference becomes effective immediately.

Viewing Help in the Application

These procedures are useful when you are seeking assistance while working in Security
Analytics. There are different ways available to get help while using Security Analytics.
Options include: Inline help, tooltips, and online help links.

View Inline Help

Inline help provides additional information about what to do in sections or fields that you are
currently viewing in the Security Analytics user interface. To display inline help, hover over

® . Inline help shows a brief description of the element.
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Inline help example:

@ Add a deployment to associate a group of rules with ESA
SETVICCS L

View Tooltips

Tooltips are a quick way for you to see a description of the text or additional information about
an action, field, or parameter. Tooltips appear as underlined text. To display the tooltip and see a
brief description of the term, hover over the underlined text.

Tooltip example:

Shows license status of each service, or group of

services mapped to a icense.

Status Senvice

View Online Help

Online help links take you outside of Security Analytics to the RSA online documentation. This
site has a complete documentation set for Security Analytics, and the links take the user directly
to the topic that describes the part of the user interface currently in view.

To view the online help topic for the current location, click ﬂ in the Security Analytics toolbar
or in a dialog. The relevant help topic is displayed in a separate browser window. The topic
describes the features and functions of the current view or dialog. From that topic, you can
quickly navigate to the related procedures.

The following figure is an example of the online help icon in the Security Analytics toolbar.

©  RSA Security Analytics

Managing Dashboards

When you enable or disable a dashboard, all the dashlets within the Dashboard are enabled or
disabled along with the associated charts, unless they are used in any other dashboard.

¢ Enabling a Dashboard

¢ Disabling a Dashboard

Enabling a Dashboard

When a dashboard is not enabled, a masked screen is displayed.
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D Dashboard

Identitv Dashbsard & @ | B 2~

Please enable the dashboard from Edit Menu & - Manage Dashboard to load data.

Security Analytics 2 admin | Last login : Wednesday, October 5, 2016 9:34:37 AM UTC | @ English (United States) | GMT+00:00

To enable one or more dashboard(s)

1. Navigate to the dashboard to be enabled.

2. In the dashboard toolbar, click :-"‘

3. Select the Manage Dashboard option.
A Manage Dashboards window is displayed.
Manage Dashboard

O Dashboard List
# ® Enable ] Disable
[l Default
™ 2 2
O 3 Past Hours
O  Identity 24 s
L] Operations - Netwerk Dashlet Refresh Interval (Minutes)
0 oOverview 5 o
[l Threat - Indicators
[ Threat - Intrusion

w
Cancel Save

4. From the dashboard list, select the Dashboard(s) to be enabled.

51 Getting Started with Security Analytics: Procedures



Security Analytics Getting Started Guide

5. Click the Enable checkbox.

6. Click Save.

Note: When you select two dashboards at the same time, the fields with the same value will
be empty and can be edited.

o

Dashboard List Displays a list of the default, Out-Of-The-Box and Cus-

tom dashboards.

® Enable Displays if the selected dashlet is enabled.

) Disable Displays if the selected dashlet is disabled.
Title Displays the titles of the selected dashlet.
Past Hours Displays the time for which the data is collected.
Dashlet Refresh Intervals Displays the refresh interval time of a dashlet. For
(Minutes) example, if you want the displayed data to refresh every

15 minutes, set this parameter for 15 minutes.

The following table describes the editable fields for different types of Dashboards.

OOTB Dashboard The refresh interval filed is editable.
Custom Dashboard with chart type dashlet All fields are editable.

Custom Dashboard without chart type dash- ~ Only the title field is editable.

let

Disabling a Dashboard

To disable one or more dashboard(s):

1. Navigate to the dashboard to be disabled.

2. In the dashboard toolbar, click z
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3. Select the Manage Dashboard option.

5. Click the Disable checkbox.

6.

A Manage Dashboards window is displayed.

Manage Dashboard
[] ' pashboard List

[0 Default

O 1

™ 2

O 2

O  Identity

[0 Operations - Network
O Overview

[0 Threat- Indicators
[0 Threat - Intrusion

-

[1  Enable
Title
2

Past Hours

24

Dashlet Refresh Interval (Minutes)

5

# O Disable

<

<>

Cancel Save

4. From the dashboard list, select the Dashboard(s) to be disabled.

Click Save.

A confirmation pop-up is displayed.

If you select a disabled dashboard, a masked screen is displayed.
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(D Dashboard

Identitv Dashk5ard

AUTC | @ English
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Configuring Dashboards

As you become more familiar with Security Analytics, there will be types of information that
you want to see quickly and easily in the dashboard. You can benefit greatly by configuring your
dashboards to display the information that supports your workflow.

Operations that pertain to dashboards include:

e Arranging the Dashboard Layout

o Adding and Managing Dashlets

o Working with Custom Dashboards

e Working with Out-Of-The-Box Dashboards

e Copying a Dashboard

o Importing and Exporting Dashboards

o Setting a dashboard as Favorite

o Sharing a Dashboard

Arranging the Dashboard Layout

To customize the views in Security Analytics, you can change the layout of the Security
Analytics dashboard or a custom dashboard.

1. Navigate to any dashboard.

2. In the dashboard toolbar, click the Edit drop-down menu ( 'ﬁ) and select Change
Dashboard Layout.
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The Change Dashboard Layout dialog box is displayed.

Change Dashboard Layout

Layout: B
'® _ — — 3 Columns
Three columns of even width.

) — — 2 Columns
Two columns of even width.

— — 2 Columns

Twao columns, the first column taking
two thirds of the space,
o — —— 2 Columns

Two columns, the first column taking

one third of the space,

S —— 1 Column
One column spanning the entire

Cancel Change

3. Choose a layout for the dashboard and click Change.
The dashboard layout is changed to the selected layout.
Move a Dashlet to a Different Position

You can arrange dashlets according to your preference by dragging and dropping them into a
different order on the dashboard.

1. To move a dashlet, hover in the header of the dashlet that you want to move.
The directional cursor k4 appears over the dashlet. Click and hold in the header of the

dashlet that you want to move.

2. Continue to hold the left mouse button and drag the window toward the new location.

The image below shows the New Live Resources dashlet as it is moved from the bottom
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position of column 1 to the top position of column 3.
® Dashboard & B @ RSA'Security Analytics |
Default Dashboard

Whats New Shortcuts
Available Services

sA ECAT D :
- KEE TK[AL Configure Live Adda Service Investigate a q

Connection
HUNT DOWN UNKNOWN MALWARE
MISSED BY OTHER TOOLS R@ Iﬁ lﬁ
¥ Lean More Browse Live Setup Live Intel Manage Liv
Resources Sharing Subscriptior

H j )

View My Jobs View My Notifications

Featured Live Resources Live Subscriptions

i Type e Live Configuration is incorrect. Please check the

Live Configuration is incorrect. Please check the
configuration.

configuration.

2 admin | € English (United States) | GMT+05:30 Send Us Feedback |

3. Release the mouse button when the dashlet is in the desired location.

The dashlet that currently occupies that position moves down.

Maximize a Single Dashlet

This topic explains how to open a dashlet on the entire area of the main Security Analytics
dashboard with the same dashlet title. For example, the Scan Jobs dashlet from the below figure
may be viewed on the entire area of the Security Analytics dashboard. Dashlets that have a lot
of columns or charts, for example some Reporting dashlets, are easier to view when maximized
so that the entire contents is visible without scrolling.

RSA ‘Security Analytics

" e

€D Dashboard O

Default Dashboard

Shortcuts Available Services

Whats New

sA ECAT D = =
7 T O 6 Name ~ Address Type
- KE—E I E il A |— Configure Live Add a Service Investigate a [] 4 Archiver1-Archi.. 103112548 Archiver

Connection Service

HUNT DOWN UNKNOWN MALWARE [] & Archiver1-Work.. 10.31.125.48 Workbench
MISSED BY OTHER TOOLS E\@ lﬁ I ﬁ [ g Archiver2-Archi..  10.31.125.49 Archiver
Loarn More Browse Live Setup Live Intel Manage Live [ & Archiver2-Work.. 10.31.125.49 Workbench
Resources Sharing Subscriptions [m] & Broker - Broker 10.31.125.46 Broker
O u [] g Concentrator-C..  10.31.12527 Concentratar
Rod o (] 'd Decoder - Decoder  10.31.125.50 Decoder
View My Jobs View My [] 4 Decoder-Wareh.. 103112550 Warehouse Con...
Notifications
[] 4 ESA-EventStrea.. 10.31.125.20 Event Stream An...
-
Featured Live Resources ~@x I SA - Malware Analysis - Scan Job... ~@.>< f New Live Resources 28X
Live Configuration is incorrect. Please check the Name Static Network community  sandtll | jve Configuration is incorrect. Please check the
configuration configuration.

No scan jobs found

2 admin | @ English (United States) | GMT+00:00 Send Us Feedback | 10.6.0.0.22018-4

1. To maximize a dashlet, click the maximize control icon " in the dashlet title bar.

The dashlet is displayed on full screen.
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2. To maximize a dashlet, click the maximize control icon " in the dashlet title bar.
The dashlet is displayed on full screen.

(@ Dashboard & B @ RSAsecurity Analytics
SA - Malware Analysis - Scan Jobs List
Name Static Network Communif ity  Sandbox Progress. Info  User Events  Dropped EventType Scheduled v

No scan jobs found

| Page of0 | | Cio v No data to display

admin | @English (United States) | GMT-+00:00 Send Us Feedbacl
dmin | ish d | d dback |

Restore the Default Dashboard

After customizing the default Security Analytics dashboard, you can revert to the original
layout of dashlets using the Restore Default Dashboard option in the Actions drop-down (
- G ). To accomplish this reversion, the dashboard of a module must be displayed.

1. Navigate to the Security Analytics dashboard which has been customized.

2. In dashboard toolbar, click the Actions drop-down (ﬁ' “) and select Restore Default

Dashboard.
The original layout of the default dashboard is restored.

Adding and Managing Dashlets

You can add dashlets to the default dashboard or construct a custom dashboard with your own
useful set of dashlets to make your workflow more efficient. Some dashlets have configuration
options to tailor the appearance or the contents of the dashlet.

Add a Dashlet

To customize the views in Security Analytics, you can add dashlets to the Security Analytics
dashboard or a custom dashboard. The Security Analytics dashboard, as the name suggests,
offers all Security Analytics dashlets. The Add a Dashlet dialog provides a way to define the
name and configurable parameters for a new dashlet.
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To add a dashlet, navigate to any dashboard.

In the dashboard toolbar, click 4 and select Add Dashlet from the drop-down menu.
The Add a Dashlet dialog is displayed.

Add a Dashlet

Type

Cance

Click on the Type selection list to display available types of dashlets, and select the type of
dashlet to add.

Additional configurable fields become available in the Add a Dashlet dialog; these vary
depending on the dashlet. For example, in an Reports RE Alert Variance dashlet, you
define the dashlet title, number of alerts, chart type, past hours, and dashlet refresh intervals
(minutes). All dashlets have a title.

Type a title for the dashlet. You can type letters, numbers, special characters, and spaces for

the name. For example, Service Monitor Dashlet could be the title.

If there are additional configurable fields for the dashlet, set appropriate values. You can

select more than one service type.
When all required fields have been configured, click Add.
The dashlet is added to the dashboard.

@ Dashboard ~ © H B @ RSASecurity Analytics

Default Dashboard © | +

Whats New ~@x g Shortcuts 2@ f Available Services 28X
RSA Security Analytics Community E E 14 weme s s
Check out the latest discussions, new how-to's, events and happenings nfigure Live Add a Service investigateaservice fl [}
around SA Col tion ED%
N5} ) SN
Browse Live Resources Setup Live Intel Manage Live Ds
Sharing. Subscriptions. Og
0] L] B
o ° Os
View My Jobs View My Notifications =
[ &
Featured Live Resources ~@x | ive Subscriptions ~> I New Live Resources 28X

. ) Name Type Description )
Live Configuration is incorrect. Please check the Live Configuration is incorrect. Please check the

configuration configuration

2 admin | @ English (United States) | GMT+05:30 Send Us Feedback |

59



Security Analytics Getting Started Guide

Edit Dashlet Properties
Some dashlets are read-only and properties are not configurable. Other dashlets are configurable
to allow users to customize some aspect of the data displayed in that dashlet. A dashlet with

editable properties has a settings icon & that displays the property sheet for editing.

A dashlet with no editable properties, such as the Live Subscriptions dashlet, does not display
the settings icon in the title bar.

Other dashlets have parameters that you define to specify the kind and amount of information
you want to see in the dashlet. The custom Investigation Dashboard has three dashlets. Each of
the three displays the settings icon.

1. To display and modify the options for a dashlet, in a dashlet title bar, click the settings icon
104

The Options dialog is displayed.

Title Investigation Top Values
Service -Decod ~
Time

Last 5 Days w
(Relative) il
Meta Type  TCP Flags g
Query
Result Limit 20 ™

Cancel Apply

2. Change any of the displayed properties. For example, in an Investigation Top Values dashlet,
you can change the Result Limit from 20 to 40.

3. Click Apply.
The following options are available for RE Top Alerts, RE Alert Variance, and RE Realtime
Charts dashlets on left-click:

o Hide For 24 Hours: This option allows you to hide the selected value for the next 24
hours. After 24 hours, the data will automatically be displayed on the dashlet, if the value
is configured and listed on top.
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o Hide Permanently: This option allows you to hide the selected value permanently until

you add it back using the Manage Hidden Values option.

o Manage Hidden Values: This option displays a list of all the hidden values. You can

select the checkbox for a value and click Remove to view the data back on the chart.

Note: The options to Hide for 24 Hours, Hide Permanently, and Manage Hidden Values
are not available for Geomap charts.

Note: When you edit a value in a preconfigured dashboard, it is a user-specific change.
The changes made to a preconfigured dashboard will be applicable only to your
dashboard and cannot be viewed by other users who use the same preconfigured
dashboard. For example, if you hide a value in an overview dashboard, the change will
be applicable only to your dashboard. If another user views the same overview
dashboard, the value will still be displayed. The same applies to a custom dashboard.
When you hide a value in the custom dashboard and share the same dashboard with
another user, the values will still be displayed even though the dashboard is shared.

For more information on available dashlets, see the Dashboards Catalog in the RSA
Content space on RSA Link.

Delete a Dashlet
1. Click the delete control icon ( X ) in the dashlet title bar:
The Remove Dashlet dialog asks for confirmation that you want to delete the dashlet.

2. If you want to delete it, click Yes. The dashlet is removed from the dashboard.

If you decide not to delete it, click No.

Note: You cannot delete dashlets associated with the Out-Of-The-Box Dashboard.

Working with Custom Dashboards

To tailor Security Analytics to better serve your site and methods, you can create custom
dashboards. Some reasons for creating custom dashboards are:

o Consolidate related functionality on a single dashboard.

o Create a Unified dashboard with a collection of dashlets for all modules.

o Create a dashboard to consolidate dashlets for different network locations.
o Create an overview of a given module's capabilities.

o Consolidate dashlets that apply to a specific scenario.
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Create a Custom Dashboard

You can create custom dashboards to serve a particular purpose; for example, to represent a

specific geographical or functional area of the network. Each custom dashboard is appended to
the dashboard selection list.

1.

In the Security Analytics dashboard, select + “ > Create New Dashboard.

The Create a Dashboard dialog is displayed.

Create a Dashboard

Dashboard Title |New Dashboard Title

Layout: =TT
——— 3 Columns
Three columns of even width.

S — — 2 Columns
Two columns of even width.

- —— — 2 Columns
Two columns, the first columnn taking two thirds of the space.

) — —— 2 Columns
Twao columns, the first column taking one third of the space.

") ——— 1 Column
One column spanning the entire width.

Cancel

Type the title for the new dashboard. You can type letters, numbers, special characters, and

spaces for the name. The permitted length of the name is 255 characters.
Select a Layout option for the new dashboard.

The dashboard is created and added to the Dashboard selection list

Now that you have created a dashboard, you can:

Add dashlets to the dashboard.
Export the dashboard.
Remove the dashboard.

Rename the dashboard.
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Select a Dashboard

1. To switch between dashboards in a Security Analytics module, click on the Dashboard
Selection List.

The Dashboard Selection List is displayed.

(D) Dashboard

Default Dashboard ~

Default

Testing Dashboard
E, Team Dashboard

Program Dashboard

Security Analytics Community

Check out the latest discussions, new how-to's, events and happenings around SA

Learn More
Serwmr P N g i & Ju—

2. Select the dashboard that you want to view.

The selected dashboard is displayed.

Rename a Custom Dashboard

1. In the dashboard toolbar, select 4 > Rename Dashboard.

The Rename Dashboard dialog is displayed.

Rename Dashboard - Default

Mew Dashboard Title Default

Cancel Rename

2. In the New Dashboard Title field, enter a new title for the dashboard.
3. Click Rename.

The dashboard is updated with the new title.

Remove a Custom Dashboard

If you find that the Dashboard Selection List in Security Analytics includes custom dashboards
that are no longer needed, you can remove the unused dashboards. The dashboard to be removed
must be displayed. The default and OOTB dashboards cannot be removed.

Note: If you want the dashboard to be available at some future time, you can export the
dashboard before removing it as described in Importing and Exporting Dashboards.
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1. In the Dashboard Selection List, select the unused dashboard; for example, Region 3.

The dashboard is displayed.

2. In the dashboard toolbar, select = .
A dialog asks for confirmation that you want to remove the dashboard.
3. To confirm deletion of the dashboard, click Yes.

The dashboard is removed from the Dashboard Selection List.

Working with Out-Of-The-Box Dashboards

On upgrade, the following Out-Of-The-Box dashboards are available:
e Overview Dashboard

« Identity Dashboard

o Threat—Indicators Dashboard

o Threat - Intrusion Dashboard

o Operations - Logs Dashboard

o Operations - Network Dashboard

For more information on each Out-Of-The-Box dashboard, see the OOTB Dashboards.

Features

Y ou cannot perform the following actions on Out-Of-The-Box Dashboard:

o Edit a dashboard
o Export a dashboard
o Share a dashboard

o Delete a dashboard

All the other features available in default and custom dashboards will be applicable in
OOTB dashboards.

A dashboard has:
e The dashboard toolbar

o The dashboard title and the Dashboards Selection List.
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Copying a Dashboard

To customize the views in Security Analytics, you can copy dashboards to the Security
Analytics dashboard or a custom dashboard. The Security Analytics dashboard, as the name
suggests, offers all Security Analytics dashlets. The Copy Dashboard dialog creates a duplicate
dashboard, the users can modify the duplicate dashboard resulting in a new dashboard. When
you copy a dashboard, the default name will be prefixed with Copy of. For example, if the name
of the original dashboard is XYZ, the default title of the copied dashboard will be Copy of XYZ.

To copy a dashboard:
1. Navigate to any dashboard.

2. In the dashboard toolbar, click @
The Duplicate Dashboard - Default dialog is displayed.

Duplicate Dashboard - Default

Dashboard Title

Cancel Duplicate

3. Enter the Dashboard Title.

4. Click Duplicate.

Importing and Exporting Dashboards

The ability to customize dashboards to changing circumstances and conditions could result in a
large number of dashboards that are not needed on a daily basis. Rather than reinvent the wheel
each time you want to recreate a particular custom dashboard, you can export your dashboards
that are not currently in use. When you are ready to use a previously exported dashboard, import
the dashboard into Security Analytics.

Export a Dashboard

Exported dashboards are designed to work within the same Security Analytics instance. It is also
possible to share your custom dashboards with other users in your organization, provided that
they have equivalent permissions.

To export a dashboard, you must have the dashboard open to access the Export Dashboard

option under the Edit drop-down menu ( 'ﬁ) in the dashboard toolbar.

Note: When you export the Reporter Realtime Charts dashboard, you must also export the
charts used in the Report Realtime Chart dashlets as they are not exported by default. When
you import the dashboard, you must manually import the dependent charts used in the Reporter
Realtime Chart dashlet.

65



Security Analytics Getting Started Guide

1. Navigate to the dashboard that you want to export. All existing dashboards appear in the
drop-down Dashboard Selection List in the currently displayed dashboard.

2. Click Export Dashboard(!) in the dashboard toolbar.

(D Dashboard @ B @ RSASecurity Analytics

Default Dashboard

Restore Default Dashboard
Whats New Export Dashboard 2@ f Available Services 28X
Import Dashboard
, ‘ EC I ;l B 'E [ # Name ~ Address Type.
KEE I E lA l — Configure Live Add a Service Investigate a O g Concentrator
Connection Service
HUNT DOWN UNKNOWN MALWARE O Warehouse Con...
MISSED BY OTHER TOOLS F‘\@ l ﬁ l ﬂ Og Decoder
Browse Live Setup Live Intel Manage Live Os Warehouse Con...
Resources Sharing Subscriptions [0 & Archiver1 Archiver
é u [ g Archiver2 Archiver
Led o [m] )f Broker Broker
View My Jobs View My [ # ESA-ContextHub Context Hub
Notifications
[] 4 ESA-EventStrea... Event Stream An...
-
Featured Live Resources 2@ Live Subscriptions 2% I New Live Resources 28X
R Palevo Tracker Domains L Type Description
B) ceated May 15,2012 10308 AW
updated Jul 31,2015 1:13:28 AM
[EY RSAFirstWatch Insider Threat Domains
5 created Feb9, 2012 448116 PM .
Updated Now 1, 2015 21 8:56 PM No matching resources found.
[ RSAFirstWatch APT Threat Domains
e created May 16, 2012 1:07:42 AM
Updated Feb 11, 2016 80843 AM

2 admin | @ English (United States) | GMT+00:00 Send Us Feedback | 10.6.0.0.22075-5

3. A warning appears at the bottom of your screen that downloaded files can harm your

computer. If this is the dashboard you wish to export, click Keep.

4. Save the exported file in the . cfg format.

Note: You cannot export Out-Of-The-Box Dashboards.

Import a Dashboard

Note: You must import the Reporter Realtime Charts dashboard and its related charts into the
same instance of the Security Analytics server and Reporting Engine from which it was
exported. You must ensure that the data sources configured for the Reporting Engine are the
same as on the Security Analytics instance from which it was exported. If you import the
dashboard and related charts into another instance of Security Analytics server, you must
ensure the data source name is updated in the charts.

1. In the dashboard toolbar, select Import Dashboard B

Import Dashboard

File (Cfg)

Cancel Import Dashboard

66



Security Analytics Getting Started Guide

2. Browse to the dashboard file in the Import Dashboard dialog. Only . cfg files are
supported.

3. Click Import Dashboard.
The dashboard is displayed in Security Analytics.

Setting a dashboard as Favorite

To customize the views in Security Analytics, you can set a dashlet as Favorite to the Security
Analytics dashboard or a custom dashboard. The Security Analytics dashboard, as the name
suggests, offers all Security Analytics dashlets. The Favorite dialog sets a specific dashboard as
your favorite dashboard and will load the favorite dashboard everytime you log in to Security
Analytics.

To set a dashboard as Favorite:

1. Navigate to any dashboard.

2. In the dashboard toolbar, click EM.

Sharing a Dashboard

In Security Analytics, you can share dashlets for viewing purposes with other roles such as
Administrators, Analysts, Operators and so on. The Security Analytics dashboard, as the name
suggests, offers all Security Analytics dashlets. When you share a dashlet, the users can only
view the dashboard, make dashboard as favorite, copy the dashboard, and eport the dashboard.
The user will be able to share their dashboard with the roles that they belong to. For example, an
analyst will be able to share his dashboard with other analysts only.

To share a dashboard:

1. Navigate to any dashboard.

2. In the dashboard toolbar, click I aland select the checkbox of the role with whom

you want to share the dashboard.

Note: If you do not want to share the dashboard, clear the checkbox of the role.

Configuring Grids

Much of the information displayed in the Security Analytics dashboards and dashlets is best
displayed in rows and columns. This is called a grid, and all grids can be customized in several
ways. You can:
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o Select which columns to display.

o Sort each column in ascending or descending order

o Change the width of columns.

This is an example of a grid (the Live Search View's Matching Resources grid).

Matching Resources

Show Results ~ |

‘E.Deploy 3 Subscribe | 3§ Package ~

[ Subscribed Name ¥ Created Updated Type Description
™ no SRI Attackers .= Sort Ascending 2014-02-21 8:01 PM RSA Feed List of malicious ip addr
= Sort Descending
™ no Hijacked &3 1:00 PM RSA Feed Hijacked ip list source f
™ yes Malware Domain List 2012-02-09 4:48 PM P 1:01 AM RSA Feed List of domains commo
™ yes Malware IP List 2012-02-09 4:48 PM M Created B 1:02 AM RSA Feed List of ip addresses con
¥ Updated

™ no Malware Domains 2012-02-09 4:48 PM B7:01 PM RSA Feed List of domains associa
¥ no Tor Exit Nodes PIIPRV R POV [V Description 7:01 AM RSA Feed This feed contains IPs t
™ no Tor Nodes 2012-02-09 4:49 PM 2014-05-21 7:02 AM RSA Feed This feed contains IPs tl
™ no Spamhaus DROP List IP Ranges 2012-07-24 5:24 AM 2014-05-21 7:.03 AM RSA Feed DROP (Don't Route Or F
™ no Spamhaus EDROP ListIP Ranges ~ 2012-07-24 5:24 AM 2014-05-21 7:.03 AM RSA Feed DROP (Don't Route Or F
™ no Windows Command Shell 2012-02-09 451 PM 2013-08-27 7:08 AM RSA FlexParser Looks for common strir
™ no TLD 2012-02-09 4:51 PM 2013-10-03 12:04 PM RSA FlexParser Extacts the top level do
™ no Alert IDs Suspicious 2012-02-09 £39 PM 2014-01-28 5:39 PM RSA Feed Name to AlertiDs mapf
™ no Alert IDs Info 2012-02-09 4:39 PM 2014-04-10 2:03 PM RSA Feed AlertlD to name mappir
™ no Alert IDs Warning 2012-02-09 4:39 PM 2014-04-10 2:03 PM RSA Feed Name to AlertlD mappi
™ no TLS 2012-02-09 £:45 PM 2014-04-18 3:16 PM RSA FlexParser Parses SSUTLS certifici
™ no MaxMind ASN 2012-02-09 4:48 PM 2014-05-21 7:04 PM RSA Feed List of AS Networks ass
™ no Netwitness Lua Library 2013-09-12 2:16 PM 2014-03-14 1:35 PM RSA Lua Parser Commonly used parser
™ no DNS - Verbose 2012-04-02 5:25 PM 2014-03-14 1:47 PM RSA FlexParser Identifies DNS sessions
™ no Windows Events (NIC) Log Coll...  2013-11-22 2:15 PM 2014-03-06 6:50 AM RSA Log Collector Log Collector configura
™ no Form Data 2012-02-09 4:44 PM 2013-10-31 432 PM RSA FlexParser Extracts metadata from
™ no MAIL_lua 2013-09-12 2:21 PM 2014-03-141:35PM RSA Lua Parser Replicates in |ua the fur
806 Matching Resources

Change the Column Width

You can change the width of a column to make columns narrower or wider than they are by
default. For example, if a column is too narrow to display all of its contents, you can widen it.

1. Hover in the title bar on the right edge of the title.

2. When the cursor changes to the column resize cursor (one short vertical line with arrows
pointing right and left), click and drag the line to make the column wider or narrower. This is
an example of resizing the Name column in progress.
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3. When the width is correct, release the mouse button.

Select Which Columns to Display

Matching Resources

[E= Show Results ~ |

[] Subscribed | Name

1 no SRI Attackers

O ne Hijacked

O yes Malware Domain List

O yes Malware IP List

= ne Malware Domains

 ne Tor Exit Nodes

I no Ter Nodes

O ne Spamhaus DROP List IP Ranges
O ne Spamhaus EDROP List IF Ranges
l no Windows Command Shell

1 no LD

O ono Alert IDs Suspicious

1 no Alert IDs Info

1 no Alert IDs Warning

l no TS

1 ne MaxMind ASN

O oo Metwitness Lua Library

1 ne DNS - Verbose

ol one windows Events (NIC) Log Coll...
l ne Form Data

I ne MAIL_lua

806 Matching Resources

| 3¢ Package -

Created

2012-02-09 4:43 PM

2012-02-09 4:48 PM

2012-02-09 4:48 PM

2012-02-09 4:48 PM

2012-02-09 4:48 PM

2012-02-09 4:43 PM

2012-02-09 4:49 PM

2012-07-24 5:24 AM

2012-07-24 5:24 AM

2012-02-09 4:51 PM

2012-02-09 4:51 PM

2012-02-09 4:39 PM

2012-02-09 4:39 PM

2012-02-09 4:39 PM

2012-02-09 4:45 PM

2012-02-09 4:48 PM

2013-09-122:16 PM

2012-04-02 5:25 PM

2013-11-22 215 PM

2012-02-09 4:44 PM

2013-09-12 2:21 PM

Updated
2014-02-21 B:01 PM

2014-05-03 1:00 PM
2014-05-12 1:01 AM
2014-05-13 1:02 AM
2014-05-18 7:01 PM
2014-05-21 7:01 AM
2014-05-21 7:02 AM
2014-05-21 7:03 AM
2014-05-21 7:03 AM
2013-08-27 7:08 AM
2013-10-03 12:04 PM
2014-01-28 5:39 PM
2014-04-10 2:03 PM
2014-04-10 2:03 PM
2014-04-18 3116 PM
2014-05-21 7:04 PM
2014-03-141:35PM
2014-03-14 1:47 PM
2014-03-06 6:50 AM
2013-10-31 4:32 PM

2014-03-14 1:35 PM

Type
RSA Feed

RSA Feed

RSA Feed

RSA Feed

RSA Feed

RSA Feed

RSA Feed

RSA Feed

RSA Feed

R5A FlexParser

RSA FlexParser

RSA Feed

RSA Feed

RSA Feed

RSA FlexParser

RSA Feed

RSA Lua Parser

RSA FlexParser

RSA Log Collector

RSA FlexParser

RSA Lua Parser

Description

List of malicious ip add:
Hijacked ip list source f|
List of domains comme|
List of ip addresses cor]
List of domains associa|
This feed contains IPs tf
This feed contains IPs tf
DROP (Don't Route Or

DROP (Don't Route Or

Looks for common stri

Extacts the top level dof
Name to AlertiDs map,

AlertiD to name mappi
Name to AlertlD mappif
Parses S5L/TLS certific.
List of AS Networks ass|
Commonly used parse

Identifies DNS sessiong
Log Collector configurs|
Extracts metadata fron]

Replicates n lua the fu

1. Hover in the title bar on the right edge of the title.

2. When the cursor changes to the selection list icon (), click to see the list.

3. At the bottom of the list, select Columns.
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A list of available columns is displayed with a check mark for each column currently
included in the grid.

Type *~ Description
RSA Feed Sort Ascending boses sourced from wWaw
Sort Descending

RSA Feed =
i Columns 2 ™ Subscribed

RSA Feed List of domains commol E Name

[ Created

# Updated
AF ist of | jat
RSA Feed List of domains associa & Type

RSA Feed List of ip addresses co

RSA Feed DROP (Don't Route Or PREAREEEIET

DCA Coand OO0 D an't Dapetn T Danel snd COOO0 sea sl

4. Select a column name to select or deselect it.

When you deselect a column name, that column is removed from the grid. When you select a
column name, that column is added to the grid. This is an example of the Matching
Resources grid after several columns are deselected.

R search “&Configure N\ Feeds [: ] RSA ‘Security Analytics
Search Criteria Matching Resources
Keywords Show Results = | | 3% Package
[0 created Updated Description
Resource Types [ 2012-02-09 446 PM 20120209 4:46 PM Custom NetWitness alert ID number.
RSA Meta Key @ Y O 2012-02-09 4:46 PM 20120209 4:46 PM The autonomous system number as defined by R...
Tags [ 2012-02-09 2:46 PM 2012-02-09 4:46 PM This file contains the decoder meta declaration n...
¥ |0 20120209246 om 2012-02.00 4:46 PM The name of the network organization as define...
Required Meta Keys [ 2012-02-09 4:46 PM 2012-02-09 4:46 PM The autonomous system number as defined by R...
[ 2012-0209 4:46 PM 2012.02.09 4:46 PM The autonomous system number as defined by R...
Generated Meta Values [ 2012:0209 246 PM 2012-02.09 4:46 PM
[ 2012:0209 4:46 PM 2012-02:09 446 PM
Resource Created Date: [ 2012-0209 4:46 PM 20120209 4:46 PM
Startbate frdbete [0 2012-02004:46 PM 2012-0200 4:46 PM This meta key identifies the name of the name of...
Resource Modified Date: [ 2012-02-09 4:46 PM 2012-02:09 446 PM This meta key identifies the name of the name of...
e - [ 2012:0209 4:46 PM 2012-02:09 4:46 PM “This meta key identifies the name of the two cha...
[ 2012-0209 4:46 PM 2012.02.09 4:46 PM “This meta key identifies the name of the two cha...
[ 2012-02-09 4:46 PM 2012-02.00 4:46 PM “This meta key identifies meta used to representc...
[ 2012:0209 4:46 PM 2012-02:09 446 PM
[ 2012-0209 4:46 PM 20120209 4:46 PM
[ 2012-0209 446 PM 2012:02.00 4:46 PM
[ 2012-02-09 4:46 PM 2012-02:00 446 PM
[ 2012:0209 4:46 PM 2012-02:09 4:46 PM
[ 2012-0209 4:46 PM 2012:02.00 4:46 PM
[ 2012-02-09 4:46 PM 2012-02.00 4:46 PM
[ 2012:0209 4:46 PM 2012:02:09 446 PM
79 Matching Resources

admin | € English (United States) | GMT+00:00 Send Us Feedback
@

Sort the Contents of a Column

To tailor a grid to better serve your purpose, you can choose how the contents of each grid
column are sorted.

1. Hover in the title bar on the right edge of the title.

2. When the cursor changes to the selection list icon ( e ) click to see the menu.
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The menu displays a list of available sort options.
3. Select from the sort options; for example, Sort Ascending or Sort Descending.

The grid is sorted based on your selection.

Managing Jobs

Inevitably, there are tasks, ad hoc or scheduled, in Security Analytics that take a few minutes to
be completed. The Security Analytics jobs system lets you begin a long-running task and
continue using other parts of Security Analytics while the job is running. Not only can you
monitor the progress of the task, but you can also receive notifications when the task has
completed and whether the result was a success or failure.

While you are working in Security Analytics, you can open a quick view of your jobs from the
Security Analytics toolbar. You can look anytime, but when a job status has changed, the Jobs

icon (E‘l) is flagged with the number of running jobs. Once all jobs are completed, that number
disappears.

You can also see the jobs in these two views.
o In the Profile view, you see the same jobs in a full panel. These are only your jobs.

o In the System view, users with administrative privileges can view and manage all jobs for all

users in a single jobs panel.

The structure of the jobs panel is the same in all views.

Display the Jobs Tray

|";"|
9

In the Security Analytics toolbar, click the Jobs icon:

The Jobs Tray is displayed.
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Jobs
|

O Job Name Recurring = Scheduled Component  Acti
[ Adhoc Scan msn_sl/3... Mo 2015-05-28 1:28am Malware View
[]  Extract PCAP No 2015-05-28 1:25am Investigati...

[l Extract Files Mo 2015-05-28 1:06am Investigati...  Dov
[[]  Extract PCAP N 2015-05-28 1:00am Investigati.. Doy

View Your jobs

The Jobs Tray lists all jobs that you own, recurring and non-recurring, using a subset of the
columns available in the Jobs panel. Otherwise the Jobs Tray and the Profile view > Jobs panel
are the same. In the Administration System view, the Jobs panel lists information about all
Security Analytics jobs for all users.

View Your Jobs

To see a larger view of your jobs, click View Your Jobs.
The Profile view > Jobs panel is displayed.

& Administration = Hosts £ Services NEventSources W Health & Wellness = System & Security & B @ RSAsecurity Analytics
Info JObS k
Updates |
Licensing O job Name Recurring | Scheduled e | G Action Message Status Progress
Email [ nwpalevo_tracker_do...  No 2016-02-16 2:12pm  Upload Cu...  admin Completed e —
Global Notifications [ HeartBleed.zip No 2016-02-16 208pm  Upload Cu... ~ admin Completed e
. netwitness.zi Ne 2016-02-16 208pm  Upload Cu...  admin Completed  com—
Legacy Notifications J P P P P
[ Apple Ne 2016-02-121:23pm  Malware admin View Completed  com—
System Logging
[ test N 2016-02-12 9:4dam  Workbench  admin Restoration Collection test cre... Completed e
Global Auditing O] Upload File No 201602-129:27am  Upload admin Completed  comm—
IJobs [ upload File Ne 2016-02-129:27am  Upload admin Completed e
Mretcanees [ Upload File Ne 2016-02-129:27am  Uplead admin Error uploading file toservice  Failed —
] Upload File N 2016-02-129:27am  Upload admin Completed e
URL Integration
[ upload File No 2016-02-129:27am  Upload admin Completed e
T N AR [ upload File Ne 2016-02-129:26am  Upload admin Completed  com—
Investigation [] SystemLiveSubscripti..  Yes 20160212 6:13am  System System Completed  Er—
ESA
HTTP Proxy Settings
NTP Settings
Log Parser Mappings
| Page 1 of1 | | C Displaying 1 - 12 of 12

2 admin | @ English (United States) | GMT+00:00 Send Us Feedback | 10.6.0.0.22075.5
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Pause and Resume Scheduled Execution of a Recurring Job

The Pause and Resume options apply only to recurring jobs. You can pause a recurring job that
is running; however, it has no effect on that execution. The next execution (assuming the job is
still paused) is skipped.

1. To stop the next execution of a recurring job, in any Jobs panel, select the job, and click
Pause.

The next execution of the job is skipped, and the schedule is paused until you click Resume.
2. To restart execution of paused recurring jobs, select the job and click Resume.

The next execution of the job occurs as scheduled, and the schedule for the job resumes.

Cancela Job
To cancel jobs that are executing or in the queue to execute:
1. Inthe Jobs Tray or either Jobs panel, select one or more jobs.
2. Click Cancel.
A confirmation dialog is displayed.
3. Click Yes.
The jobs are canceled, and the entries remain in the grid with a status of canceled.

If you cancel a recurring job, it cancels that execution of the job. The next time the job is
scheduled to run, it executes normally.

Delete a Job

Caution: When you delete a job, the job is instantly deleted from the grid. No confirmation
dialog is offered. If you delete a recurring job, all future executions are removed as well.

Users can delete their own jobs before, during, or after execution. Users with the ADMIN role
can delete any job. To delete jobs:

1. Select one or more jobs.
2. Click Delete.

3. The jobs are deleted from the grid.
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Download a Job

When a job has the Download status in the Action column, you can download the result of the
job. If you are working in the Investigation Module and extract the packet data for a session as a
PCAP file or extract the payload files (for example, Word documents and images) from a
session, a file is created. To download the file to your local system, click Download.

Viewing and Deleting Notifications

While you are working in Security Analytics, you can view recent system notifications without
leaving the module in which you are working. You can open a quick view of notifications from
the Security Analytics toolbar. You can look anytime, but when a new notification is received,
the Notifications icon is flagged.

Examples of notifications include:

o A host upgrade completed.
o A parser push to decoders completed.

o A newer software version is available.

You can see all notifications in a full Notifications panel in these two views.

o In the Profile view, you see only your notifications.

o Inthe System view, users with administrative privileges can view and manage all

notifications for all users in a single panel.

View Notifications

To display the Notifications tray, in the Security Analytics toolbar, click the Notifications icon (

=,
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Notifications

Host Updates Available
Mew Host updates are available, Please click on the 1 Day
link below to perform updates View »

Job Error X
Error retrieving PCAP from service: 1 Day
TimeoutException: Timeout waiting for task. View =»

File Extraction Complete X

The file extraction is complete and ready for 1 Day
download. View =

View All

View All Notifications

To view all notifications, do one of the following:

1. Inthe Security Analytics menu, select Profile, then in the options panel of the Profile view,
select Notifications.

2. In the Security Analytics menu, select Administration > System, then in the options

panel of the System view, select Notifications.

3. Inthe Security Analytics toolbar, click E to open the Notifications tray, then click View
All in the Notifications tray.

The Notifications panel is displayed. Here all notifications are displayed, and the format is
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different from the format of the Notifications Tray.

@ B @ RSAsecurity Analytics

Preferences Notifications

| Notifications

Jobs O itle Message Created v
(] Host Updates Available New Host updates are available. Please lick on the link below to perform Updates View » 2015-05.28 2:17am
O JobError Error retrieving PCAP from service: TimecutException: Timeout waiting for task. View s 20150528 1:55am
[ File Extraction Complete  The file extraction is complete and ready for download. View » 20150528 1:06am
(] PCAP Extraction Complete  The PCAP extraction is complete and ready for download. View s 20150528 1:00am
[ Service Restart Required Config change has been applied to QAMALWARET newitness.loeal - Broker service. Restart s required for the configura...  2015-05-28 12:54am
[ Service Restart Required Config change has been applied to QALighting - Concentrator service. Restart is required for the configuration to take ef...  2015-05-28 12:35am
(] Host Updates Available New Host updates are available. Please lick on the link below to perform Updates View » 20150528 12:16am
[ service Added QALighting - Concentrator service has been added to QALighting host during enabling View » 2015-05.28 12:06am
[ Service Restart Required Config change has been applied to QATITAN.netwitness.local - Decoder service. Restart s required for the configuration...  2015-05-27 Gr16am
[ service Added QAESAT.netwitness. ocal - Event Stream Analysis service has been added to QAESAT.netwitness.ocal host during enabli..  2015-05-27 2:29am
[ Service Added QALIGHTNING.netwitness.ocal - Concentrator service has been added to QALIGHTNING netwitness.Jocal host duringe...  2015-05-27 226am
[ Service Added QATITAN.netwitness.local - Decoder service has been added to QATITAN.netwitness.local host during enabling View » 20150527 2:13am
[ Service Added QAMALWARET netwitness. local - Broker service has been added to QAMALWARET.netwitness.local host during enabling...  2015-05-27 212am
[ Service Added QAMALWARET netwitness. local - Malware Analysis service has been added to QAMALWAREN.netwitness local host durin...  2015-05-27 Z12am
[ Service Added SA - Broker service has been added to SA host during enabling View » 2015-05.27 1:56am
[ Service Added SA-Reporting Engine service has been added to SA host during enabling View » 2015-05.27 1:56am
[ Service Added SA - Malware Analysis service has been added to SA host during enabling View » 2015-05.27 1:56am
[ Service Added SA-1PDB Extractor service has been added to SA host during enabling View » 2015-05.27 1:56am
[ Sanica Addad SA_Incidnnr Manannmant canica har han ardad tn SA hact durine anabling o . 215 18 77 156 2em
| Page |1 of1 | |1 C Displaying 1 - 20 of 20

admin | &) English (Uniced States) | GMT+05:30 Send Us Feedback

Delete Notification Records

To delete notification records:
1. Inthe Profile Notifications grid, select the notifications that you want to delete.

2. Click == Delete

The selected notifications are deleted from this grid and from the Notifications Tray.
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Getting Started with Security Analytics:

References

The Security Analytics user interface includes features such as:

o Profile View > Preferences Panel

o Notifications Panel and Notifications Tray

e Jobs Panel and Jobs Tray

e Admin News Dashlet

e Admin Service List Dashlet

e Dashboard RSA First Watch Dashlet

o Dashboard Shortcuts Dashlet

o Dashboard What's New Dashlet

o Incidents Analysts Activity Dashlet

o Incidents Queue Activity Dashlet

o Investigation Jobs Dashlet

o Investigation Top Values Dashlet

o Live Featured Resources Dashlet

o Live New Resources Dashlet

o Live Subscriptions Dashlet

o Live Updated Resources Dashlet

o Malware Malware with High Confidence IOCs and High Scores Dashlet

e Malware Scan Jobs List Dashlet

e Malware Top Listing of Possible Zero Day Malware Dashlet

o Malware Top Listing of Highly Suspicious Malware Dashlet

o Reports Realtime Chart Dashlet

e Reports RE Alert Variance Dashlet

e Reports Recent Run Report Dashlet
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e Reports RE Recent Alerts Dashlet

o Reporting RE Top Alerts Dashlet

This section includes an example of each one. You may find the examples of dashlets useful

when deciding how to customize your dashboards.
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Jobs Panel and Jobs Tray

Jobs are started by various Security Analytics modules; for example, the Live module can
download CMS resources, the Administration module can upload a feed to a service, and the
Investigation module can analyze and reconstruct packets in packet capture files.

In the Administration System view, users in the ADMIN group can manage all Security
Analytics jobs in the Jobs panel. Other non-administrative users can view their own jobs in the
Profile view.

In addition, while working in Security Analytics, you can open a quick view of your jobs from

the Security Analytics toolbar. When a job status has changed, the Jobs icon (ﬁ) is flagged
with the number of running jobs. Once all jobs are completed, that number disappears.

In the Jobs panel, you can:

o View and sort the jobs
o Pause or resume a job
o Cancel a job
o Delete a job

o Download a job

The structure of the jobs panel is the same in all views. Procedures associated with the Jobs
panel and Jobs tray are described in Managing Jobs.

To access the Jobs panel, do one of the following:

o Inthe Security Analytics menu, select Administration > System, and in the options panel,
select Jobs.
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# Administration Hosts = Services Event Sources Health & Wellness
Info Jobs L3
Updates |
Licensing [ jobName Recurring  Scheduled Component | Owner Action Message Status Progress
Email [] nwpalevo_tracker do..  No 201602-16 2:12pm  Upload Cu...  admin Completed  E—
Global Notifications ] HeartBleed.zip No 20160216 208pm  Upload Cu...  admin Completed  e—
- netwitness.zi No 20160216 208pm  Upload Cu...  admin Completed  e—
Legacy Notifications o P P o P
1 Apple No 20160212 1:23pm  Malware  admin View Completed e
System Logging
O test No 20160212 9:44am  Workbench  admin Restoration Collection test cre...  Completed e
Global Auditing [ Upload File No 2016-02-129:27am  Upload admin Completed e
] sobs [ Upload File No 2016-02-129:27am  Upload admin Completed  eo—
Live Services (] Upload File No 20160212 9:27am  Upload admin Error uploading fileto service  Failed —
. (] Upload File No 2016-02-129:27am  Upload admin Completed  emm——
URL Integration
(] Upload File No 2016-02-129:27am  Upload admin Completed  e—
Context Menu Actions ] Upload File No 20160212 9:26am  Upload admin Completed  emm—
Investigation ] SystemLiveSubscripti..  Yes 20160212 6:13am  System System Completed  emm—
ESA
HTTP Proxy Settings
NTP Settings
Log Parser Mappings
| Page 1 of1 | | C Displaying 1-120f 12

2 admin | @English (United States) | GMT+00:00 Send Us Feedback | 10.6.0.0.22075-5

o Inthe Security Analytics menu, select Profile, and in the options panel, select Jobs.

L Profile O B @ RSAsecurity Analytics
Preferences Jobs
Notifications |
| Jobs O jobName Recurring | Scheduled Component | Owner Action Message Status Progress
] nwpalevo_tracker_do..  No 20160216 2:12pm  Upload Cu... admin Completed  emm—
[ HeartBleedip No 20160216 2:08pm  Upload Cu... admin Completed  eom—
[0 netwitness.zip No 20160216 2:08pm  Upload Cu... admin Completed  emm—
[ Apple No 201602121:23pm  Malware  admin View Completed  eom—
O test No 2016-02-129:44am  Workbench  admin Restoration Collection test create.. ~ Completed — eom—
[ Upload File No 20160212 9:27am  Upload admin Completed  mm—
[ Upload File No 20160212 9:27am  Upload admin Completed  emm—
[ Upload File No 20160212 9:27am  Upload admin Error uploading file to service Failed —
[ Upload File No 20160212 9:27am  Upload admin Completed  emm—
[ Upload File No 20160212 9:27am  Upload admin Completed  mm—
[ Upload File No 20160212 9:26am  Upload admin Completed  emm—
| Page 1 | of1 | 1 C Displaying 1-11 0f 11

admin | @ English (United States) | GMT+00:00

s Feedback | 1

-
To display the Jobs tray, in the Security Analytics toolbar, click the Jobs icon 9 .
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|

L] Job Name Recurring = Scheduled Component  Acti|
] Extract PCAP MNo 2015-02-25631pm  Investigati..  Dov
L] Extract PCAP Mo 2015-02-25 8230pm  Investigati..  Dov
[ Extract Logs Mo 20150219 456pm  Investigati.. Dov

View Your Jobs

The Jobs panel organizes information about jobs into a grid. The columns present a job progress
bar, the job name, an indication that the job is recurring or not recurring, the Security Analytics
module that is controlling the job, the owner of the job, the status, any associated message, and a
download button to allow downloading of a job's packet capture files or payload files.

Features

The Jobs tray lists all jobs that you own, recurring and non-recurring, using a subset of the
columns available in the Jobs panel. Otherwise the Jobs tray and the Profile View > Jobs panel
are the same. In the Administration System view, the Jobs panel lists information about all
Security Analytics jobs for all users.

This table lists the toolbar options in the Jobs panel.

Foawrs Jpmmerpin

The Resume option applies only to recurring jobs that have been paused.

b
k' Resume e, you resume a paused job, the next execution of the job executes as
scheduled.
The Pause option applies only to recurring jobs. When you pause a recurring
—
‘I’ Pause

job that is running, it has no effect on that execution. The next execution

(assuming the job is still paused) is skipped.

Cancels a recurring or non-recurring job. You can cancel a job while it is run-

=
= Cancel ning. If you cancel a recurring job, it cancels that execution of the job. The

next time the job is scheduled to run, it executes normally.
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e Jowemn

Deletes a recurring or non-recurring job from the Jobs panel. When you delete
a job, the job is instantly deleted from the Jobs panel. No confirmation dialog
is offered. If you delete a recurring job, all future executions are removed as

well.

This table describes the Jobs tray and Jobs panel features.

P omerpn

Selection

box
Progress

Job Name

Recurring

Component

Owner

Status

Message

Action

Click in this box to select one or more jobs.

Shows the percentage complete for a job.
Displays the name of the job; for example, Extract Files or Upgrade Service.

Indicates whether the job is recurring or non-recurring. Yes = recurring, No =

non-recurring.

Indicates the component in which the job originated; for example, Investigation

or Administration.

Indicates the owner of the job. The owner of the job is not included in the default
Jobs Tray, because only the current user's jobs are displayed here. The column

1s available to add.

Indicates the status of the job. Common values for status are Paused, Running,

Canceled, Failed, Completed, and other status values are possible.

Displays additional information about the job; for example, Extracting files or

No sessions found.

Views job in the Investigation Malware Analysis view, or downloads job files
for the job to the default Downloads directory on the local system. Only suc-
cessfully completed jobs have the View link in the Action column. Only jobs that

create a file have the Download link in the Action column.
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View Your
" Displays jobs in the Profile View > Jobs panel.
Jobs

Scheduled Indicates the date and time at which the job was scheduled to begin.
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Notifications Panel and Notifications Tray

Security Analytics provides system notifications to advise users about certain actions or
conditions.

o A host upgrade completed.

o A parser push to decoders completed.

o A service went down (critical log of a certain type).
o A visualization completed.

A report completed.

o A newer software version is available.

While you are working in Security Analytics, you can view recent system notifications without
leaving the module in which you are working. You can open a quick view of notifications from
the Security Analytics toolbar. You can look anytime, but when a new notification is received,
the Notifications icon is flagged.

When you are viewing notifications in the Notifications tray, only recent notifications are
displayed. You can view all notifications in a grid format in the Profile view or in the System
view. Procedures for viewing notifications are provided in Viewing and Deleting Notifications.

To access the Notifications panel, do one of the following:

o In the Security Analytics menu, select Profile, then in the options panel of the Profile view,

select Notifications.
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o In the Security Analytics menu, select Administration > System, then in the options panel of

the System view, select Notifications.

2 Profile

Preferences Notifications

| Notifications

Jobs Title

Job Error

Service Added

Service Added
Service Added
Service Added
Service Added
Service Added
Service Added
Service Added
Service Added

Service Added

jooooooDoDooooooooooon

| Page 1

Host Updates Available

File Extraction Complete
PCAP Extraction Complete
Service Restart Required
Service Restart Required

Host Updates Available

Service Restart Required

of 1 |

O B @

Message
New Host updates are available. Please click on the link below to perform updates View »
Error retrieving PCAP from service: TimeoutException: Timeout waiting for task, View »
The file extraction is complete and ready for download. View »

The PCAP extraction is complete and ready for download. View »

Config change has been applied to QAMALWARE netwitness.local - Broker service. Restart s required for the configura...

Config change has been applied to QALighting - Concentrator service. Restart s required for the configuration to take ef...

New Host updates are available. Please click on the link below to perform updates View »

QALighting - Concentrator service has been added to QALighting host during enabling View »

Config change has been applied to QATITAN.netwitness.local - Decoder service. Restart is required for the configuration..
QAESA1.netwitnessocal - Event Stream Analysis service has been added to QAESA1.netwitness.lacal host during enabli..
QALIGHTNING netwitness.local - Concentrator service has been added to QALIGHTNING.netwitness.local host during e.
QATITAN.netwitness.local - Decoder service has been added to QATITAN netwitness local host during enabling View »

QAMALWARE netwitness.local - Broker service has been added to QAMALWARE 1 .netwitness local host during enabling...

QAMALWARE netwitness.local - Malware Analysis service has been added to QAMALWARET.netwitness.local host durin...

SA- Broker service has been added to SA host during enabling View »
SA-Reporting Engine service has been added to SA host during enabling View »
SA-Malware Analysis service has been added to SA host during enabling View »

SA-IPDB Extractor service has been added to A host during enabling View »

1 C

RSA ‘Security Analytics

Created v
2015-05-28 2:17am
2015-05-28 1:55am
2015-05-28 1:06am
2015.05-28 1:00am
2015.05-28 12:54am
2015.05-28 12:35am
2015.05-28 12:16am
2015-05-28 12:06am
2015-05-27 9:16am
2015-05-27 2:29am
2015-05-27 2:26am
2015.05-27 2:13am
2015.05-27 2:12am
2015.05-27 2:12am
2015.05-27 1:56am
2015-05-27 1:56am
2015-05-27 1:56am
2015-05-27 1:56am

Displaying 1 - 20 of 20

admin | @ English (United States) | GMT+05:30 Send Us Feedback
gl
1

o In the Security Analytics toolbar click E, then click View All in the Notifications tray.

Motifications

download. View »

Job Error

Job Error

Features

Logs Extraction Complete
The log extraction is complete and ready for 2015/01/08

Error retrieving logs from service View » 2015/01/08

Error retrieving logs from service View » 2015/01/08

File Extraction Complete b4
The file extraction is complete and ready for 2015/01/07

X

X

View All

The Notifications panel and tray has a toolbar and a grid. The Notification tray is a subset of the
information in the Notifications panel. The following table describes the Notifications panel

features.
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Title

Message

View

Created

View All

Displays a drop-down menu where you can delete the selected notification records
or all the notification records in the Notifications grid and in the Notifications

Tray.
The title of the notification, for example, File Extraction Complete.

The entire message, for example, The file extraction is complete and ready for

download.

Some messages include a link that displays a view where you can take action. For
example, if there is a file to download, clicking this link opens the Jobs panel, the

view where you can download the file.

The date and time the notification was created.
In the Notifications Tray, this column is the number of days since the notification

was created.

Displays the Profile View Notifications Grid.
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Profile View > Preferences Panel

Users can set several preferences that are applied on top of system preferences set by the
System Administrator. These include:

o General preferences for Security Analytics and settings for the Security Analytics application

as a whole (described below)
o Preferences that apply to Investigation and can affect initial views and load time

o Preferences that apply to Reporter.

To access this panel:
1. In the Security Analytics menu, select Profile.

2. In the options panel of the Profile view, select Preferences.

The panel is displayed with the General tab selected.

L Profile
4 Investigation

Preferences
A Incidents
™ Alers General | Investigation
e
lad Reports
& Administration Authentication
[RENE

2 Profile

¢ signout

onfirr ey

Application Settings

Language English (United States) v
Browser Time Zone UTC (GMT+00:00) v
Default Component Dashboard v

¥ Enable Notifications
¥ Show Context Menus

8 odmin | Lostlogin: Thursday, Augus: 3AMUTC | @pEngis

Features
The Preferences panel > General tab has two sections: Authentication and Application Settings.

Authentication

The following table describes options in the Authentication section. The related procedure is
described in Changing Your Password.
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Current Password

New

Password

Confirm
Password

Apply

Enter your current password that you used to log in to

Security Analytics.

Enter the password that you want to use from the next
login . The password must be at least 8 characters in
length, and can include uppercase and lowercase let-
ters, numbers, special characters, and spaces.
Confirm Password Re-enter the new password to
confirm.

Updates your user profile with the new password. The
new password becomes effective immediately and is
required the next time you log on to Security Analytics.
The password change is applied to your system log on
and to all Security Analytics services on which your

account has been added.

Application Settings

The following table describes options in the Application Settings section. Related procedures are

described in Configuring Application Preferences.

Fews Jossctpten

Language

Browser Time

Zone

Default Component

Enable Noti-

fications

Displays a drop-down list of languages available to use in Security Ana-

Iytics.

Displays a drop-down list of time zones available to use in Security Ana-

lytics.

This field has a drop-down list for selecting the component that serves as

the opening view when you log on to Security Analytics.

This checkbox enables and disables notifications for your user account.
By default, Security Analytics system notifications are enabled when a

new user account is created.
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This checkbox enables and disables context menus for your user account.

Show Context By default, Security Analytics context menus are enabled when a new
Menus user account is created. Context menus provide additional functions for

specific views when you right-click in a view.

Apply Updates the application settings and the changes are applied imme-
diately.
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Admin News Dashlet

This dashlet presents product information and updates for the Administration module.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard, in
the dashboard toolbar, select + - > Add a Dashlet in the dashboard and select Admin News.

Admin News A X

Instant Motifications
¢ Maotification indicators are integrated right into the Security Analytics
©

interface, providing real-time job status and system messages to
anahysts without interrupting workflow.

Active Directory Integration
d}@ Take advantage of existing structure with the ability to bind Security

Analytics group permissions to Active Directory domain groups. Use
the domain to provide authentication, and define groupauthorizations
in Security Anahytics.

Real-Time Rule Alerting

a Utillize SMMP traps with an extension of previous rule logic capability
_ 1 | -

" 0 Loy g =N ek D " L ool

Admin Service List Dashlet

The Administration Service List dashlet is a list of available services in Security Analytics with
links to administrative tasks that can be taken on those services. In effect, this dashlet is a
focused subset of the Administration Hosts View (see the topic in the Hosts and Services
Getting Started Guide.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,
select +o. Add Dashlet in the dashboard toolbar and select Admin Services List.
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Services List A X
O # Name ~ Address Type

L & Incident Mana...
U & Archiver

L ¢ Eroker

] & Concentratar
U o Decoder

L & Event Stream .
L # Log Decoder
Features

o The View menu () option is a quick link to the View menu in the Administration Services

view. Select a service and click here to select a view.
o The Navigate option is a quick link to the Navigate view in the Investigation module.

o The Services grid has a subset of the grid columns in the Administration Hosts view. The

following table provides descriptions of the columns presented in the dashlet

Selection checkbox. Click in the heading to select or deselect all services in the
list.

Connection The connection icons indicate whether the connection to the service is good

Status (green) or bad (red and gray). Rendering of the entire row in red text also
& reflects a bad connection status.
Name The name of the service; for example HQ-Decoder or 10.26.22.44-Decoder.

91 Getting Started with Security Analytics: References



Security Analytics Getting Started Guide

Address The IP address of the NextGen service; for example, 10.26.22.44.

Type The type of service. Possible values are Broker, Concentrator, Decoder, Log
Decoder, Log Collector, Archiver, Workbench, Warehouse Collector, Event
Stream Analysis, IPDB Extractor, Reporting Engine, Malware Analysis, and

Incident Management.
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Dashboard RSA First Watch Dashlet

The Dashboard RSA First Watch dashlet delivers situational awareness and threat intelligence
from across the RSA research and incident-response community, providing customers the
intelligence to prepare for, respond to, and mitigate advanced cyber threats. The RSA First
Watch, Incident Response, and Computer Incident Response Center (CIRC) teams

track millions of IPs and domains, as well as dozens of unique threat sources and threat actors.

To display this dashlet in the Unified dashboard or as part of a custom dashboard, click + - >
Add Dashlet in the dashboard toolbar and select Dashboard RSA First Watch.

RSA First Watch A X

Date Article

m The Danger of Denial

| wias very surprised recently, in a corversation | had with someones | used
to work with, to hear him remark that he didn't think there is amy such thing
as stealthy, targeted attacks.

Read More [

Jigsaw - Just Another Piece of the Puzzle in an Attack
Campaign #INTH3WILD

E-mail has long been usad as an effective attack vector for delvering
mahware and conducting phishing attacks.

Read More [

Features

Date The date the article was posted.

Article The article title, a sample of the article, and a "Read More" link to the full article.
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Dashboard Shortcuts Dashlet

The Dashboard Shortcuts dashlet offers quick links to common tasks in other areas of Security
Analytics. It is a good tool for first-time users who are trying to get a feel for the system.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + - > Add Dashlet in the dashboard toolbar and select the Dashboard
Shortcuts dashlet.

Shortcuts Ao P
LD B =
Configure Live Add a Service Investigate a
Connecticn Service
L D D
Browse Live Setup Live Intel Manage Live
Resources Sharing Subscriptions
H B
View My Jobs View My
Motifications

Features

In addition to the standard dashlet controls, this dashlet has options that link to common Security
Analytics tasks.

o om0

Configure Links to the Administration System View > Live Configuration Panel, where
Live Con- you configure the connection to the Live content management system.
nection

Add a Ser- Links to the Services View.

vice
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Investigate a  Links to the Navigate View Navigate Tab, in which you can select a

Service service to navigate from a list of available services.

Browse Live Links to the Live Search View, in which you search the Live resource library

Resources for resources.

Setup Live Links to the Administration System View, in which you can choose to par-

Intel Sharing ticipate in live intelligence sharing.

Manage Live Links to the Live Configure View, in which you view and edit subscriptions

Subscriptions  and deployments.

View My Links to the Jobs Panel (Profile View), in which you view Security Analytics
Jobs jobs.

View My Links to the Notifications Panel (Profile View), in which you view system noti-

Notifications  fications.
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Dashboard What's New Dashlet

The Dashboard What's New dashlet displays the latest product information and announcements

for all Security Analytics products.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + - > Add Dashlet in the dashboard toolbar and select Dashboard What's New

dashlet.

RSA Security Analytics
Community

Check out the latest discussions, new how-to's,

events and happenings around SA
Serwr e

What's New A X
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Incidents Analysts Activity Dashlet

The Incidents Analysts Activity dashlet shows the number and status of incidents per
analyst, over a range of time. It displays three categories:

o Closed incidents
e Open incidents

o Remediation in progress

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + . Add Dashlet in the dashboard toolbar. Select Incidents Analysts Activity from
the drop-down menu and set a time range for the activity.

Analyst Activity Dashlet A X
Last 30 Days

30

|
. .
1EI_I
Administrator J anvi Badlani Sphurthy G angapuram test2 user
Jagat Parekh Ramya Gopalan test! user testd user

| @ Closed incidents [ Open incidents [l Remediation in progress |

Note: When you collapse the dashlet using the - option, the bars take some time to
redisplay. You can refresh the browser to see the graph quickly.

Fewrs owserpten

Bar graph  When you hover the mouse over a portion of the bar graph, the number and status

of incidents is displayed in text.

Incident  In the legend at the bottom, incident categories are displayed. Clicking a category

categories removes it from the graph. Clicking the category again redisplays it in the graph.
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Incidents Queue Activity Dashlet

The Incidents Queue Activity dashlet displays the total number of alerts, incidents, and
remediation tasks for a selected time range.

To display this dashlet on the Security Analytics dashboard or as part of a custom dashboard,

click + . Add Dashlet in the dashboard toolbar and select Incidents Queue Activity. In
the Add a Dashlet dialog, enter a title for the dashlet and select a time range for results.

The figure below is an example of the dashlet with information from the last 7 days.

Incident Queue Activity

Last 7 Days

‘_ Total # of Alerts
J\A.- Total # of Incidents

EJ Total # of Remediation

10909

T 10878

23

412

6

T6

X

e e

Totals Separate rows display the totals of alerts, incidents, and remediation.

Clicking a total opens the respective tab for alerts, incidents, or remediation.

Increase The number below the total is the amount of increase or decrease. A total that has

and changed more than 33% is in red. A total that has changed less than 33% is in

Decrease  gray.
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Investigation Jobs Dashlet

The Investigation Jobs dashlet displays the status of all jobs in the Investigation module. The
toolbar, grid, and job management procedures are described under Jobs Tray.

To display this dashlet in the default dashboard or as part of a custom dashboard, click + .
Add Dashlet in the dashboard toolbar and select Investigation Jobs.

Investigation Jobs X
|

[]  job Name Recurring  Scheduled Component  Owner
[] ExtractFiles No 2014-05-231:03pm  Investigati... admin
[] ExtractFiles No 2014-05-231:00pm  Investigati... admin
[ ExtractFiles No 2014-05-23 12:48...  Investigati... admin
[ ExtractPCAP No 2014-05-23 12:40...  Investigati.. admin
[ ExtractFiles No 2014-05-23 12:38...  Investigati.. admin

| Page 1 (of11 | » DI C Displaying 1 - 20 of 214

Features

The Investigation Jobs dashlet lists all jobs that you own, recurring and non-recurring, and lets
you monitor their progress.

e foewn

4 Resume The Resume option applies only to recurring jobs that have been paused. When

you resume a paused job, the next execution of the job executes as scheduled.

The Pause option applies only to recurring jobs. When you pause a recurring job
' Pause  that is running, it has no effect on that execution. The next execution (assuming

the job is still paused) is skipped.

Cancels a recurring or non-recurring job. You can cancel a job while it is run-

® Cancel g 1f ! ing job, i i '
g. If you cancel a recurring job, it cancels that execution of the job. The next

time the job is scheduled to run, it executes normally.
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Deletes a recurring or non-recurring job from the Jobs panel. When you delete a

job, the job is instantly deleted from the Jobs panel. No confirmation dialog is

offered. If you delete a recurring job, all future executions are removed as well.
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Investigation Top Values Dashlet

The Investigation Top Values dashlet allows you to inspect the top values for a specific time
period and for a specific meta type on a given appliance. You define the meta data and query
parameters in the Add a Dashlet dialog.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click +- . Add Dashlet in the dashboard toolbar and select Investigation Top Values.

Top User Account Sessions A X
/ Last 5 Days
User Account

admin (633460) default (72952) nagiocsadmin (41671)

anonymous (28245) 2048 (5991) 10240 (1978) 49154 (1673)

32768 (1671) 2049 (BB3) 6145 (B62) 2050 (849) 4097 (843) 4098 (830)
4096 (829) 2051 (772) 6147 (711) 81894 (707) 4089 (703) 10242 (703)
6144 (700)

Features

You define the meta data and query parameters in the Add a Dashlet dialog.

e =

Title The title of the dashlet.

Service The name or IP address of the target service.

101 Getting Started with Security Analytics: References



Security Analytics Getting Started Guide

e o

Time (Relative) Last 5 minutes
Last 10 minutes
Last 15 minutes
Last 30 minutes
Last Hour
Last 3 Hours
Last 6 Hours
Last 12 Hours
Last 24 Hours
Last 2 Days
Last 5 Days

meta Type Select the meta type from the drop-down list.
Query Complete the query to further define the results

Result Limit Select the number of results to display from the drop-down list.
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Live Featured Resources Dashlet

The Live Featured Resources dashlet displays the list of Live resources that are tagged as
featured for the configured Content Management System (CMS) server.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + - > Add Dashlet in the dashboard toolbar and select Live Featured Resources.

Live Featured Resources A X
Netwitness Lua Library

ﬁ_ created Sep 12, 2013 2:16:06 PM

Updated Mar 14, 2014 1:35:28 PM

DNS - Verbose

ﬁ_ created Apr2, 2012 5:25:06 PM

updated Mar 14, 2014 1:47:50 PM

Form Data

E_ created Feb 9, 2012 4:44:53 PM

updated Oct 31, 2013 4:32:53 PM

MAIL lua

E_ created Sep12, 2013 2:21:33 PM

updated Mar 14, 2014 1:35:17 PM

Features

This dashlet has a paged view of featured Live resources and provides the following information
about each resource.

ﬁ' Each type of Live resource is represented by an icon. For example, the icon in
(Resource the screen capture represents a Parser feed. Clicking the Resource Type icon
Type opens a new browser tab with the detailed view of the resource in the Live
Icon) Resource view.

Resource  The name of the resource, for example, NetWitness APT Threat IPs. Clicking
Name the Resource Name displays the detailed view of the resource in the Live
Resource view. The view opens in the current browser tab.

Date The date the resource was created.
Created
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Last The date the resource was last updated.
Updated
Date
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Live New Resources Dashlet

The Live New Resources dashlet displays a list of Live CMS resources that are tagged as new
for the configured Content Management System (CMS) server. You can click a resource name
to go to the detailed view of the resource.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + - > Add Dashlet in the dashboard toolbar and select Live New Resources.

Live New Resources A X

created May 20, 2014 5:15:52 PM
updated May 20, 2014 5:15:57 PM

ﬂ User added to admin group then ip ...

= Non DNS Traffic on TCP or UDP Por ...
ﬂ created May 20, 2014 5:15:43 PM
updated May 20, 2014 5:15:48 PM

= Global Filtering Candidate Report
created May 20, 2014 £36:10 PM

updated May 20, 2014 4:36:15 PM

= Scanning Activity
created May 20, 2014 £:35:58 PM
updated May 20, 2014 4:36:05 PM

A 4 4 4

Features

This dashlet has a paged view of new Live resources and provides the following information
about each resource.

Each type of Live resource is represented by an icon. For example, the icon to the
E left represents a Decoder FlexParser. Clicking the Resource Type icon opens a

new browser tab with the detailed view of the resource in the Live
Resource

Resource view.
Type Icon
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Resource

Name

Date
Created

Last
Updated
Date

The name of the resource, for example, GhOst Protocol Parser. Clicking
the Resource Name displays the detailed view of the resource in the Live

Resource view. The view opens in the current browser tab.

The date the resource was created.

The date the resource was last updated.
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Live Subscriptions Dashlet

The Live Subscriptions dashlet presents a listing of all Live resources to which this Security
Analytics instance is subscribed. This is simply a quick reference list. If you need to manage
subscriptions, use the Subscriptions Tab in the Live Manage view.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click +- . Add Dashlet in the dashboard toolbar and select Live Subscriptions.

Live Subscriptions A X
Mame Type Description

NTP Parser Decoder Flex...  Parser to identify NTP. Requires that the NTP
Internet Printing Protocol  Decoder Flex..  IPPis an application level protocol that can by
Encoded File Fingerprin...  Decoder Flex... forensically identifies encoded files on the wi

Third Party IOC Domains ~ Decoder Feed  Contains domains published as malicious fro

ShadyRat Decoder Flex...  This parser alerts on base64-encoded comm
Malware Domains Decoder Feed  List of domains associates with malware sou
Fingerprint PDF Decoder Flex...  Forensically identifies PDF files on the wire.

BGP Protocol Identificat..  Decoder Flex..  This parser is to identify BGP Routing Protocd

Features

The grid is a subset of the subscriptions grid in the Live Manage View.

Name Displays the name of the subscription.
Type Specifies the type of subscription.
Description Describes the type of information supplied by the subscription.
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Live Updated Resources Dashlet

The Live Updated Resources dashlet displays a list of Live CMS resources that are tagged as
updated for the configured Content Management System (CMS) server. You can click on the
resource title to go to a detailed view of the resource.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,
click +- . Add Dashlet in the dashboard toolbar and select Live Updated Resources.

Live Updated Resources A X

e Tor Nodes

ﬁ created Feb9, 2012 4:49:18 PM
updated May 27,2014 11411 PM

= Tor Exit Nodes

ﬁ created Feb9, 2012 4:49:17 PM
updated May 27, 2014 1:01:48 PM

created Jul 24, 2012 5:24:16 AM
updated May 27, 2014 7:03:37 AM

F Spamhaus EDROP List IP Ranges

= Spamhaus DROP List IP Ranges
ﬁ created Jul 24, 2012 5:24:15 AM
updated May 27, 2014 7:02:31 AM

Features

This dashlet has a paged view of updated Live resources and provides the following information
about each resource.

This dashlet has a page view of featured Live resources and provides the fol-

lowing information about each resource.

F Each type of Live resource is represented by an icon. For example, the icon in the
screen capture represents a Decoder feed. Clicking the Resource Type icon opens
Resource a new browser tab with the detailed view of the resource in the Live Resource
Type view.
Icon
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The name of the resource, for example, Spamhaus EDROP List IP Ranges.

Resource o i ) ) ) )
Clicking the Resource Name displays the detailed view of the resource in the Live

Name Resource view. The view opens in the current browser tab.

Date The date the resource was created.

Created

Last The date the resource was last updated.

Updated

Date
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Malware Malware with High Confidence IOCs and High Scores
Dashlet

The Malware Malware with High Confidence IOCs and High Scores dashlet presents the events
that Malware Analysis detected with Indicators of Compromise, high likelihood of harboring
malware, and high scores in the scoring modules. This dashlet is available in the Unified
dashboard and in the Malware view. When a Malware Analyst first logs on to Security
Analytics, by default the only visible dashlet in the Unified view is the What's New dashlet. The
analyst must create any additional Malware dashlets.

The Malware Malware with High Confidence IOCs and High Scores dashlet is configurable.
You can create multiple copies of the dashlet, filter results, and configure the display of results
as an Events List or a Files List.

To display this dashlet in the Security Analytics Dashboard or as part of a custom dashboard,

click +- . Add Dashlet in the dashboard toolbar and select Malware Malware with High
Confidence IOCs and High Scores from the Type drop-down menu.

This is an example of the Malware Malware with High Confidence IOCs and High
Scores dashlet settings.

Add a Dashlet

Type |Malware Malware with High Conf +

Title Malware with High Confidence 10Cs
™ Influenced By High Confidence Only

Static o

Network o

Community o

sandbaox

Service

Time

] Last 5 Days
[Relative)

Result Limit |10

® Show Events () Show Files

Cancel
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This is an example of the Malware Malware with High Confidence IOCs and High
Scores dashlet.

Malware with High Confidence IO... A %

gh Confidence Only, Time = Last 5 Days, Service= | - Malw

2 static Netwaork Community = Sandbox AV

2 N o < O R

2

Hi
O
|
|
|
|
|
|
|
|

e ca S S Qe

s

Features

The following table lists configurable values for this dashlet.

Identifies the name of the dashlet. Each dashlet needs a unique name, espe-
Title cially if you have more than one instance of the same dashlet. The name

appears in the title bar of the dashlet.

Influenced by ~ When checked, only events and files that were flagged as High Confidence
High Con- (or likelihood) for containing Indicators of Compromise are displayed in the

fidence Only  dashlet.

Static, Net- Filters the results based on the scores for each scoring module. You can set
work, Com- the value as =, <=, or >=.
munity,
Sandbox

Sets the number of results to be displayed. Possible values in the drop-down
Result Limit

list are 5, 10, 20, 30, or 40.
Service Selects the service to be monitored.
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Time (Rel- Limits the time range of displayed results.

ative)

Show Events  Specifies the form of the results, either Events List or Files List format.

or Show Files
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Malware Scan Jobs List Dashlet

The Malware Scan Jobs List dashlet displays the same Scan Jobs List found in the Select a
Malware Service dialog. You can open completed scans directly from this dashlet.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + - > Add Dashlet in the dashboard toolbar and select Malware Scan Jobs List.

MName Static Metwork
Adhoc Scan img...

Adhoc Scan ww...

Adhoc Scan appl...

Adhoc Scan dow...

Adhoc Scan 00:2...

Adhoc Scan clou..

Adhoc Scan spec...

Adhoc 5can clou...

| Page 1

- Malware Analysis - SCu.. A 5 7%

Community

of2 | > N1 C 10

Sandbox

~  Displaying

Features

The columns in this Scan Jobs list are the same as those in the Scan Jobs List in the Select a

Malware Service dialog.

Double-clicking on a job allows you to view a job in the Investigation > Malware Analysis view.
The Summary of Events for the selected scan opens with the default dashlets displayed in a new

browser tab.
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Malware Top Listing of Possible Zero Day Malware Dashlet

The Top Listing of Possible Zero Day Malware dashlet presents the top 10 events indicative of a
possible zero day attack in the Malware Analysis Events List or the Files List. This dashlet is
available in the dashboard and in the Malware view. When a Malware Analyst first logs in to
Security Analytics, by default the only visible dashlet in the view is the What's New dashlet.
The analyst must create any additional Malware dashlets.

The Top Listing of Possible Zero Day Malware dashlet is configurable. You can create multiple
copies of the dashlet, filter results, and configure the display of results as an Events List or a
Files List. From this dashlet, you can launch an Malware Analysis investigation of an event
directly by double-clicking the event; you do not have to go to the Investigation > Malware view
to begin.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + . Add Dashlet in the dashboard toolbar and select Malware Top Listing of
Possible Zero Day Malware from the Type drop-down menu.

This is an example of the dashlet settings configured to display the Events List.

Add a Dashlet

Type Malware Top Listing of Possible 2 +
Title Top Listing of Possible Zero Day Mal

L1 Influenced By High Confidence Only

Static =u~ 2= v
Metwork o = v
Community %~ <=
Sandbox & 2= v
Service v
Time ) Last 5 Days v
[Relative)

Result Limit 10 i

® Show Events () Show Files
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This is an example of the dashlet. The features in the dashlet are the same as those on the
Malware Analysis Events List or the Files List.

Top Listing of Possible Zero Day ... 7%
Time = Last 5 Days, Service= ' - Malware Analysis

O A static Network Community  Sandbox AV
O (N T (—

O (N TN (N C——

O (N T (—

O (N TN (N C——

O (N TN (N C—

O (N TN (—

O (N TN (N

O (N TN (—

M ENTEE O (N
Features

The following table lists configurable values for this dashlet.

Identifies the name of the dashlet. Each dashlet needs a unique name, especially
Title if you have more than one instance of the same dashlet. The name appears in

the title bar of the dashlet.

Influenced  When checked, only events and files that were flagged as High Confidence (or
by High likelihood) for containing Indicators of Compromise are displayed in the dashlet.
Confidence

Only

Static, Net-  Filters the results based on the scores for each scoring module. You can set the
work, Com- value as =, <=, or >=. The operator for the community filter is less than or equal
munity, to the applied slider value by default. The operator for the other filters is greater
Sandbox than or equal to by default.

Service Selects the service to be monitored.
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Time (Rel- Limits the time range of displayed results.

ative)

Result Sets the number of results to be displayed. Possible values in the drop-down list
Limit are 5, 10, 20, 30, or 40.

Show Specifies the form of the results, either Events List or Files List format.

Events or

Show Files
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Malware Top Listing of Highly Suspicious Malware Dashlet

The Malware Top Listing of Highly Suspicious Malware dashlet presents the top 10 most
suspicious events in the Malware Analysis Events List or the Files List. This dashlet is available
in the dashboard and in the Malware Analysis view. When a Malware Analyst first logs in to
Security Analytics, by default the only visible dashlet dashboard is the What's New dashlet. The
analyst must create any additional Malware Analysis dashlets.

The Malware Top Listing of Highly Suspicious Malware dashlet is configurable. You can create
multiple copies of the dashlet, filter results, and configure the display of results as an Events List
or a Files List.

To display this dashlet in the Security Analytics Dashboard or as part of a custom dashboard,

click + . Add Dashlet in the dashboard toolbar and select Malware Top Listing of Highly
Suspicious Malware from the Type drop-down menu.

Add a Dashlet

Type Malware Top Listing of Highly Su: v
Title Top Listing of Highly Suspicious Mal
™ Influenced By High Confidence Only

Static = < m= v
Network &= <o == v
Community = = 2= v

Candbox = Be W
Service w
Time _ Last 5 Days W
(Relative)

Result Limit |10 ~

® Show Events () Show Files

Cancel

This is an example of the dashlet.
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Top Listing of Highly Suspicious M... Az~
High Confidence Only, Time = Last 5 Days, Service= . - Malw
Ll 4 static Network Community = Sandbox AV

O & EEDEE DD (D e ©

O &% EEDEE DD D EETEE ©

O &% EEDEE DI EETEE T o

O & I I (S BT ©

O &% EEDEE DD D EETEE ©

O & EEDEE DN (D EETEm ©

O 4 EEDEE D BT e o

O % EEDINE D BT s o

Features

The features are the same as the features of the Malware Analysis Events List and Files List
(see the Investigation and Malware Analysis Guide for details). To launch a Malware Analysis
investigation of an item in the dashlet, double-click an event or file name in the grid.

The following table lists configurable values for this dashlet.

Title

Influenced by
High Con-
fidence Only

Static, Net-
work, Com-
munity,

Sandbox

Service

Identifies the name of the dashlet. Each dashlet needs a unique name, espe-
cially if you have more than one instance of the same dashlet. The name

appears in the title bar of the dashlet.

When checked, only events and files that were flagged as High Confidence
(or likelihood) for containing Indicators of Compromise are displayed in the

dashlet.

Filters the results based on the scores for each scoring module. You can set

the value as =, <=, or >=.

Selects the service to be monitored.
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Time (Rel- Limits the time range of displayed results.
ative)
Result Limit Sets the number of results to be displayed. Possible values in the drop-down

list are 5, 10, 20, 30, or 40.

Show Events  Specifies the form of the results, either Events List or Files List format.

or Show Files
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Reports Realtime Chart Dashlet

The Reports Realtime Chart dashlet displays one of the charts from the list of charts that you
defined. The chart output is from the live data and it refreshes itself based on the refresh interval
that you set. Each chart is defined by the Chart Type and Past Hours value that you select.

You can select either the Chart Values over Time or Chart with Totals option. The chart graphs
the current data and does not display data points for historical data.

The chart is generated for data depending on the time interval that you defined in the chart
definition. The data are available from a maximum of the past 20 time intervals. For example, if
in the chart definition you selected a refresh interval as five minutes and past hour as one hour,
the chart displays data from the past 60 minutes. The chart in the dashlet refreshes itself based
on the dashlet refresh interval that you have defined. In the Past Hours field, you can select
values between 1 to 72 hours. The default value is 24 hours.

Type Reports Realtime Chart w

Chart frealtime-chart Browse

Title realtime-chart

Series Chart with Totals e

Chart Type | Column)| -

Past Hours |72 -+

Dashlet

Refresh -
5 o

Interva

(Minutes)

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + . Add Dashlet in the dashboard toolbar and select the Reports Realtime
Chart from the Type drop-down menu.
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realtime-chart
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Features

Chart options are listed in the following table.

Chart

Title

Series

Chart Type

Past Hours

Dashlet Refresh

Interval (Minutes)

Select a chart from the already defined charts. You can select only one

chart per dashlet.

Type a name for the Reporting Realtime Chart dashlet. The name
appears in the title bar of the dashlet.

Chart Values over Time: The chart displays the change in values for

the selected time.

Chart with Totals: The chart displays a total for each aggregate value

for the selected time.

Select the type of chart that you want in the dashlet. The values provided

in the drop-down are: bar, column, and line.
Select the past time interval.

Set the time interval in minutes at which the data in the dashlet gets

refreshed. The interval value ranges from 1-180 minutes.
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Reports RE Alert Variance Dashlet

The Reports RE Alert Variance dashlet is a configurable dashlet that depicts top alerts in four
different time series chart types. You can configure the results to include in the chart (from the
top 2 alerts to the top 15 alerts in the specified time range).

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

select +o Add Dashlet in the dashboard toolbar and select Reports RE Alert Variance
from the Type drop-down menu.

Type

Title

Mo Of Alerts
Chart Type

Past Hours

Dashlet
Refresh
Interval
(Minutes)

Add a Dashlet

Reports RE Alert Variance

RE Alert Variance
3
Line

24

Cancel

The following figure is an example:

L

L

L

Getting Started with Security Analytics: References

122



Security Analytics Getting Started Guide

RE Alert Variance AL X
75 -
| & |
50
-
=
=
o
L
25
! 06:00 06:30 07:00 07:30 08:00 08:30
== Rule_1(1) == Rule_STRING_WValid_Syntax -e- Rule_FLOAT(1) == Rule_FLOAT

Features

This dashlet is a visual representation of the alerts most frequently triggered by the associated
Reporting Engine. Each chart type can be defined by the number of alerts and past hours from
when the alerts need to be fetched, and the dashlet refresh interval for the chart to be refreshed.

Title

No of Alerts

Chart Type

Past Hours

Dashlet Refresh

Interval (Minutes)

Provide a name for the Reporter Realtime Chart dashlet. The name

appears in the title bar of the dashlet.

Select the number of alerts to be considered while configuring the dash-
let. The value ranges from 2 - 15.

Select the type of chart that you want in the dashlet:

o Bar (X-axis = Count and Y-axis = Alert name)

o Column (X-axis = Count and Y-axis = Alert name)

o Line (X-axis = Count and Y-axis = Alert name)
Select the time from when the alerts need to be fetched.

Set the time interval in minutes at which the data in the dashlet gets

refreshed. The interval value ranges from 1-180 minutes.
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Reports Recent Run Report Dashlet
The Reports Recent Run Report dashlet consists of a list of reports that were run recently in
Security Analytics. The recent reports displayed are from the last 24 hours.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + . Add Dashlet in the dashboard toolbar and select Reports Recent Run Report
from the Type drop-down.

Recent-Reports A X

Report Mame Run Config Time

test test_SSL 08:11 =
Features

The columns present in the dashlet by default are described in the following table.

Report Name The name of the recently run report.

Run Config The run configuration of the recently run report.
Time The time the report was scheduled.

Export Click on the export icon ( ff] ) to export the file.
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Reports RE Recent Alerts Dashlet

The Reports RE Recent Alerts dashlet displays the latest alerts on the dashboard. You can
configure the number of latest alerts to be displayed and also specify the time range from when

the alerts needs to be fetched.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + . Add Dashlet in the dashboard toolbar and select Reports RE Recent
Alerts from the Type drop-down menu.

Add a Dashlet

Type Reports RE Recent Alerts
Title RE Recent Alerts
Top 10

Past Hours 24

Cancel

The following figure is an example:

L

RE Recent Alerts

Name

Rule_1(1)
Rule_1(1)
Rule_1(1)
Rule_1(1)
Rule_1(1)
Rule_1{1)
Rule_1(1)
Rule_1{1)
Rule_1(1)

Rule_1{1)

AT X

Detected

2016/01/25 14:06:01
2016/01/25 13:36:01
2016/01/25 13:06:01
2018/01/25 12:36:01
2016/01/25 12:06:01
2016/01/25 11:36:01
2016/01/25 11:12:01
2018/01/25 11:10:01
2018/01/25 11:07:01

2016/01/25 11:06:02
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Features

The following table describes the columns in the Reports RE Recent Alerts dashlet.
Name The name of the alert as defined.

Detected The date and time that the alert fired. This detection time is when Security Ana-

lytics detected the conditions for firing this alert.
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Reporting RE Top Alerts Dashlet

The Reports RE Top Alerts dashlet is a configurable dashlet that depicts top alerts in four chart
types. You can configure the results to include in the chart (from the top 2 alerts to the top 15
alerts in the specified time range).

The chart is summarized for each top alert against the number of events triggered by the alert for
the defined time and refresh intervals. The first data point in the chart defines the number of
events (alert count) triggered by the alert for the defined time. The subsequent data points are
depicted by adding the alert count in the first data point and alert count in the defined refresh
intervals.

For example, if for the defined time range, the number of events (alert count) triggered by the
alert is 10, then the first data point in the chart is shown as 10. The subsequent data point = 10 +
number of events (alert count) triggered by the alert in the defined dashlet refresh interval.

To display this dashlet in the Security Analytics dashboard or as part of a custom dashboard,

click + . Add Dashlet in the dashboard toolbar and select Reports RE Top Alerts from
the Type drop-down menu.

Add a Dashlet
Type Reports RE Top Alerts v
Title RE Top Alerts
Top 10 -
Chart Type | Bar v
PastHours 12 -
Dashlet
Refresh 1II|| -
Interval
(Minutes)

The following figure is an example:
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RE Top Alerts A7 X
o ]

400

COUNT

200

i Rule_1(1) ' Rule_STRING Vald 5. Rule_FLOAT{1) '
TIME

Features

This dashlet is a visual representation of the alerts most frequently triggered by the associated
Reporting Engine. Each chart type can be defined by the number of top alerts, the time from
when the alerts needs to be fetched, and the dashlet refresh interval for the chart to be refreshed.

Select the type of chart that you want in the dashlet:

o Bar (X-axis = Count and Y-axis = Alert name)

Column (X-axis = Count and Y-axis = Alert name)

Chart Type
o Pie
o Line (X-axis = Count and Y-axis = Alert name)
o Tabular (X-axis = Count and Y-axis = Alert name)
1 Type a name for the Reporting Realtime Chart dashlet. The name
Title
appears in the title bar of the dashlet.
Select the number of top alerts to be considered while configuring the
Top
dashlet. The value ranges from 2 - 15.
Past Hours Select the time from when the alerts need to be fetched.
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Dashlet Refresh Set the time interval in minutes at which the data in the dashlet gets

Interval (Minutes)  refreshed. The interval value ranges from 1-180 minutes.
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